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Utiliser LibreOffice sur un Mac

Sur Mac, certaines touches et certains éléments de menu sont différents de ceux utilisés sous 
Windows ou Linux. Le tableau ci-dessous donne quelques substitutions courantes pour les instruc-
tions de ce chapitre. Pour une liste plus détaillée, voyez l’Aide de l’application.

Windows ou Linux Équivalent Mac Effet

Sélection du menu 
Outils > Options

LibreOffice > Préférences Accès aux options de configuration

Clic droit
Control+clic ou clic droit 
selon la configuration de l’ordinateur

Ouvre un menu contextuel

Ctrl (Control) ⌘ (Command) Utilisé avec d’autres touches

Ctrl+Q ⌘+Q Quitter LibreOffice

F11 ⌘+T Ouvre l’onglet Styles du volet latéral

La documentation française de LibreOffice est disponible à
https://wiki.documentfoundation.org/Documentation/Publications/fr
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Introduction

Vous pouvez saisir des données dans Calc de différentes manières : en utilisant le clavier, la sou-
ris (glisser et déposer), l’outil Remplir et les listes de sélection. Calc donne également la possibilité
d’entrer de l’information dans plusieurs feuilles d’un même document en une seule fois. Vous pou-
vez formater les données saisies et les afficher de plusieurs façons.

Saisir des données en utilisant le clavier

La plupart des saisies de données dans Calc peuvent être faites en utilisant le clavier.

Saisir des nombres

Cliquez dans la cellule et tapez le nombre en utilisant les touches numériques soit de la partie prin-
cipale du clavier, soit du pavé numérique. Par défaut, les nombres sont alignés à droite.

Nombres négatifs

Pour saisir un nombre négatif, tapez le signe moins (-) devant lui ou entourez-le de parenthèses, 
comme ceci : (1234). Le résultat des deux méthodes de saisie est le même : −1234.

Zéros non significatifs

Si un nombre est saisi dans le format 01481, Calc supprimera le 0 devant ce nombre. Pour conser-
ver un nombre minimum de caractères dans une cellule en préservant le format numérique, par 
exemple 1234 et 0012, utilisez l’une des méthodes suivantes pour ajouter des zéros non significa-
tifs :

Avec la boîte de dialogue Formatage des cellules

 1) Après avoir sélectionné la cellule, ouvrez la boîte de dialogue Formatage des cellules par 
l’une des méthodes suivantes : 

– faites un clic droit sur la cellule et sélectionnez Formater les cellules dans le menu 
contextuel,

– sélectionnez Format > Cellules dans la barre de menu,

– utilisez le raccourci Ctrl+1 au clavier.

 2) Vérifiez que l’onglet Nombres est bien visible (Figure 1) et choisissez Nombre dans la liste 
Catégorie.

 3) Dans la section Options, saisissez le nombre minimum de caractères exigés dans la zone 
de saisie Zéros non significatifs. Dans notre exemple, entrez 4 : tout nombre qui nécessite 
moins de quatre caractères sera précédé de zéros non significatifs ; 12 s’écrira 0012.

 4) Cliquez sur OK. Le nombre conserve son format numérique et sera traité comme tel par les 
formules utilisées dans le classeur.
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Figure 1 : L’onglet Nombres de la boîte de dialogue Formatage des cellules.

Avec le volet latéral

 1) Sélectionnez la cellule.

 2) Dans le volet latéral, ouvrez l’onglet Propriétés puis la section Format numérique (cliquez 
sur le + ou ˅ à gauche du titre pour l’ouvrir).

 3) Choisissez Nombre dans la liste déroulante située sous le titre de la section.

 4) Tapez 4 dans le champ Zéros non significatifs. Le format est immédiatement appliqué.

Figure 2 : Définir le nombre de zéros non significatifs

Nombres sous forme de texte

Les nombres peuvent aussi être saisis sous forme de texte grâce à l’une des méthodes suivantes :
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Avec la boîte de dialogue Formatage des cellules

 1) Après avoir sélectionné la cellule, ouvrez la boîte de dialogue Formatage des cellules par 
l’une des méthodes suivantes :

– faites un clic droit sur la cellule et sélectionnez Formater les cellules dans le menu 
contextuel,

– sélectionnez Format > Cellules dans la barre de menu,

– utilisez le raccourci Ctrl+1 au clavier.

 2) Vérifiez que l’onglet Nombres (Figure 1) est sélectionné puis choisissez Texte dans la liste 
Catégorie.

 3) Cliquez sur OK. Le nombre saisi est converti en texte et aligné par défaut à gauche.

Avec le volet latéral

 1) Sélectionnez la cellule.

 2) Dans le volet latéral, ouvrez l’onglet Propriétés puis la section Format numérique (cliquez 
sur le + ou ˅ à gauche du titre pour l’ouvrir).

 3) Choisissez Texte dans la liste déroulante située sous le titre de la section (Figure 2). Le for-
matage est immédiatement appliqué à la cellule.

 4) Cliquez sur la cellule. Saisissez le nombre et activez une autre cellule pour que la donnée 
soit mise en forme.

Remarque

Par défaut, tout nombre mis en forme comme texte dans un classeur sera traité comme un 
zéro par toutes les formules utilisées. Les fonctions ignorent les entrées textuelles dans les 
formules.

Cette fonctionnalité peut être changée dans la boîte de dialogue Options  : Outils > Options
> LibreOffice Calc > Formule en cochant Personnalisé (conversion de texte en nombres, 
et autres) dans la section Paramètres de calcul détaillés puis en sélectionnant le traite-
ment approprié dans la boîte de dialogue Paramètres de calcul détaillés qui s’ouvre en cli-
quant sur le bouton Détails…

Saisir du texte

Cliquez dans la cellule et tapez le texte. Les textes sont alignés à gauche par défaut.

Pour saisir un texte de plusieurs lignes dans une cellule, vous pouvez insérer des retours à la ligne
en tapant Ctrl+Entrée.

Vous pouvez agrandir la zone de saisie en cliquant sur le bouton Étendre la barre Formule . La 

zone de saisie comporte alors plusieurs lignes (Figure 3). Cliquez à nouveau sur ce bouton  pour
revenir à la zone de saisie initiale.
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Étendre la barre de formule

Figure 3 : Agrandir la ligne de saisie de la barre de formule.

Saisir des dates et des heures

Sélectionnez la cellule et tapez la date ou l’heure.

Vous pouvez séparer les éléments de la date avec une barre oblique (/) ou un tiret (-) ou utiliser 
un texte comme 10 octobre 2021. Vous pouvez séparer les éléments d’une heure par des deux-
points comme 10:43:45. Calc reconnaît plusieurs formats de date et d’heure ; le format utilisé par 
Calc s’appliquera automatiquement.

Remarque

L’option Formats de date acceptés de la section Langue de dans la boîte de dialogue Op-
tions : l’onglet Outils > Options > Paramètres linguistiques > Langues définit les formats 
de date reconnus par Calc, avec les notations suivantes : D pour le jour, M pour le mois et Y
pour l’année. En outre, chaque locale accepte les saisies dans un modèle Y-M-D ISO 8601.

Pour modifier le format utilisé par Calc pour afficher les dates et les heures, appliquez une des mé-
thodes suivantes.

Avec la boîte de dialogue Formatage des cellules

 1) Après avoir sélectionné la cellule, ouvrez la boîte de dialogue Formatage des cellules par 
l’une des méthodes suivantes :

– faites un clic droit sur la cellule et sélectionnez Formater les cellules dans le menu 
contextuel,

– sélectionnez Format > Cellules dans la barre de menu,

– utilisez le raccourci Ctrl+1 au clavier.

 2) Vérifiez que l’onglet Nombres (Figure 1) est bien visible et choisissez Date ou Heure dans la 
liste Catégorie.

 3) Sélectionnez le format de date ou d’heure que vous désirez utiliser dans la liste Format.

 4) Cliquez sur OK pour enregistrer le changement et refermer la boîte de dialogue.

Avec le volet latéral

 1) Sélectionnez la cellule.

 2) Dans le volet latéral, ouvrez l’onglet Propriétés puis le panneau Format numérique (cliquez 
sur le + ou ˅ à gauche du titre pour l’ouvrir).

4 | Chapitre 2 – Saisir, modifier et formater des données



 3) Choisissez Date ou Heure dans la liste déroulante située sous le titre de la section (Figure 
2).

 4) Cliquez sur le bouton Plus d’options ( ) dans la barre de titre du panneau pour ouvrir la 
boîte de dialogue Formatage des cellules (Figure 4).

 5) Choisissez le format que vous désirez utiliser dans la liste Format.

 6) Cliquez sur OK.

Plus d’options

Figure 4 : Format Date

Remarque

Le format de date est influencé par les réglages de langue du système et du classeur.

Astuce

Les raccourcis clavier Ctrl+; et Maj+Ctrl+; permettent d’entrer la date et l’heure cou-
rante dans la cellule, respectivement formatées en date et en heure. L’entrée est effectuée 
sous forme de valeur. Comme ce ne sont ni des fonctions ni des champs, les données ne 
sont pas actualisées par la suite.

Saisir des caractères spéciaux

Un caractère “spécial” est un caractère qui ne se trouve pas sur un clavier français standard. Par 
exemple, © ¾ æ π å ø ¢ sont tous des caractères spéciaux. Pour insérer un caractère spécial :

 1) Placez le curseur dans votre document où vous voulez que le caractère apparaisse.

 2) Cliquez sur Insertion > Caractères spéciaux pour ouvrir la boîte de dialogue Caractères 
spéciaux (Figure 5).

 3) Sélectionnez le caractère souhaité dans la grille. Il apparaît en haut à droite de la boîte de 
dialogue accompagné de son code numérique.

 4) Les derniers caractères sélectionnés sont indiqués sous la grille et peuvent être sélectionnés
comme les autres.

 5) En bas de la boîte de dialogue, une petite collection de Caractères favoris est proposée 
d’origine. Pour ajouter un caractère à la liste des favoris, sélectionnez-le puis cliquez sur le 
bouton Ajouter aux favoris. Pour supprimer un caractère de cette liste, sélectionnez-le et 
cliquez sur le même bouton dont l’intitulé est alors Supprimer des favoris.
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 6) Cliquez sur Insérer pour insérer le caractère dans la cellule et refermer la boîte de dialogue. 
Vous pouvez aussi faire un double clic sur le caractère pour l’insérer sans refermer la boîte 
de dialogue, ce qui permet d’en sélectionner d’autres.

Astuce

Pour insérer rapidement les caractères récents ou favoris, cliquez sur l’icône Insérer des 
caractères spéciaux  dans la barre d’outils Standard puis sélectionnez le caractère 
voulu dans la palette. Vous pouvez cliquer sur Plus de caractères pour ouvrir la boîte de 
dialogue Caractères spéciaux (Figure 5).

Remarques

Les différentes polices comprennent des caractères spéciaux différents. Si vous ne trouvez 
pas le caractère spécial particulier que vous voulez, essayez de changer la sélection et le 
sous-ensemble de police grâce aux listes déroulantes en haut de la boîte de dialogue.

Figure 5 : La boîte de dialogue Caractères spéciaux.

Options d’autocorrection

Calc applique automatiquement plusieurs changements durant la saisie de données, à moins que 
vous n’ayez désactivé cette fonction. Vous pouvez également annuler immédiatement chaque 
changement automatique avec Ctrl+Z ou en revenant manuellement à la modification pour rem-
placer l’autocorrection par ce que vous désirez voir vraiment.

Pour modifier les options d’autocorrections, sélectionnez Outils > Options d’autocorrection dans
la barre de menu pour ouvrir la boîte de dialogue AutoCorrection (Figure 6).
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Onglet Remplacer
Éditez la table de remplacement pour la correction automatique ou le remplacement de mots
ou d’abréviations dans votre document.

Onglet Exceptions
Précisez les abréviations ou combinaisons de lettres que vous ne voulez pas voir automati-
quement corrigées par LibreOffice.

Onglet Options
Sélectionnez les options pour la correction des erreurs en cours de frappe.

Onglet Options linguistiques
Spécifiez les options d’autocorrection des guillemets et d’autres options particulières à la 
langue utilisée pour les textes.

Terminez en cliquant sur OK pour valider vos modifications ou sur Réinitialiser pour rétablir les 
valeurs précédentes.

Figure 6 : La boîte de dialogue AutoCorrection.

! Attention

Les options d’AutoCorrection sont communes à tous les modules : les modifier dans Calc, 
les modifiera aussi dans Writer ou Impress par exemple.

Insérer des tirets

Pour saisir des tirets moyens et longs, vous pouvez utiliser l’option Remplacer les tirets dans l’on-
glet Options de la boîte de dialogue AutoCorrection. Cette option remplace deux traits d’union, 
sous certaines conditions, par le tiret correspondant.

Dans le tableau suivant, A et B représentent un texte constitué de lettres de A à z et de chiffres de 
0 à 9.
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Texte que vous tapez Résultat

A - B (A, espace, moins, espace, B) A – B (A, espace, tiret moyen, espace, B)

A -- B (A, espace, moins, moins, espace, B) A – B (A, espace, tiret moyen, espace, B)

A--B (A, moins, moins, B) A—B (A, tiret long, B)

A-B (A, moins, B) A-B (sans modification)

A -B (A, espace, moins, B) A -B (sans modification)

A --B (A, espace, moins, moins, B) A –B (A, espace, tiret moyen, B)

Accélérer la saisie des données

La saisie de données dans un classeur peut demander beaucoup de travail, mais Calc fournit plu-
sieurs outils pour en alléger certaines corvées, parmi lesquels, le glisser-déposer pour déplacer ou
copier le contenu d’une cellule dans une autre avec la souris, un outil d’autosaisie, l’outil Remplir et
les listes de sélection.

L’outil Remplir et les listes de sélection automatisent la saisie de données répétitives dans les cel-
lules. Calc offre aussi la possibilité de saisir de l’information dans plusieurs feuilles du même docu-
ment.

Utiliser l’outil AutoSaisie

La fonction AutoSaisie de Calc complète automatiquement la saisie en cours dans une cellule et 
s’appuyant sur le contenu des autres cellules de la même colonne. Un maximum de 2 000 cellules 
et 200 chaînes différentes peuvent être utilisées dans ce but.

Quand un élément de texte mis en évidence vient compléter ce que vous êtes en train de taper, 
l’autosaisie peut être utilisée :

• pour accepter la proposition : appuyez sur Entrée ou F2 ou cliquez avec la souris ;

• pour voir d’autres propositions : utilisez les combinaisons Ctrl+Tab pour passer à la sui-
vante ou Ctrl+Maj+Tab pour passer à la précédente.

• pour ouvrir une liste de tous les éléments d’autosaisie disponibles : utilisez la combinaison 
Alt+↓ (Flèche vers le bas).

Lors de la saisie de formules utilisant des caractères qui correspondent à des noms de fonctions, 
une infobulle apparaît avec les dix dernières fonctions utilisées dans l’Assistant Fonction qui com-
mencent par les caractères correspondants.

L’autosaisie ne distingue pas les majuscules des minuscules dans ce que vous saisissez. Par 
exemple, si vous avez tapé « Total » dans une cellule, vous ne pouvez pas entrer « total » dans 
une autre sans désactiver d’abord l’autosaisie.

L’autosaisie est activée par défaut. Pour la désactiver, ouvrez le menu Outils et décochez Auto-
Saisie.

Utiliser l’outil Remplir les cellules

L’outil Remplir de Calc permet de dupliquer le contenu existant ou de créer une suite dans une 
plage de cellules de votre classeur.
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 1) Sélectionnez la cellule qui contient ce que vous désirez copier ou l’amorce de la série.

 2) Tirez la souris dans n’importe quelle direction ou appuyez sur la touche Maj et cliquez sur la 
dernière cellule que vous voulez remplir.

 3) Sélectionnez Feuille > Remplir les cellules dans la barre de menu puis la direction dans la-
quelle vous voulez copier ou créer les données (Remplir vers le bas, Remplir vers la 
droite, Remplir vers le haut, Remplir vers la gauche), Remplir la série, ou Remplir de 
nombres aléatoires dans le sous-menu. Les options non disponibles sont grisées.

Vous pouvez aussi utiliser un raccourci pour remplir les cellules (Figure 7).

 1) Sélectionnez la cellule qui contient ce que vous désirez copier ou l’amorce de la série.

 2) Déplacez le pointeur sur le petit carré en bas à droite de la cellule sélectionnée. Le pointeur 
change de forme.

 3) Cliquez et tirez dans la direction où vous désirez remplir les cellules. Si la cellule initiale 
contenait du texte, celui-ci sera automatiquement recopié. Si la cellule initiale contenait un 
nombre (seul ou en fin de chaîne), une suite croissante sera créée si vous tirez vers la droite
ou vers le bas, décroissante si vous tirez vers la gauche ou vers le haut.

 4) Si la cellule initiale contient un nombre et que vous appuyez simultanément sur la touche 
Ctrl, son contenu est recopié au lieu d’être incrémenté ou décrémenté.

             
Figure 7 : Utiliser l’outil Remplir

! Attention

Quand vous sélectionnez des cellules pour utiliser l’outil Remplir les cellules, vérifiez 
qu’aucune ne contient de données sauf celle qui servira de départ à l’opération : toutes les 
données contenues dans les autres cellules seront écrasées.

Utiliser des séries de remplissage

Quand vous choisissez Feuille > Remplir les cellules > Remplir la série dans la barre de menu, 
la boîte de dialogue Remplir la série s’ouvre (Figure 8). Vous pouvez y sélectionner le type de sé-
rie que vous voulez.

Direction
Cette section définit la direction dans laquelle la suite est créée.

– L’option Bas crée une suite du haut vers le bas de la plage de cellules sélectionnées en 
utilisant l’incrément défini jusqu’à la valeur finale.
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– L’option Droite crée une suite de gauche à droite dans la plage de cellules sélectionnées 
en utilisant l’incrément défini jusqu’à la valeur finale.

– L’option Haut crée une suite du bas vers le haut dans la plage de cellules sélectionnées 
en utilisant l’incrément défini jusqu’à la valeur finale.

– L’option Gauche crée une suite de droite à gauche dans la plage de cellules sélection-
nées en utilisant l’incrément défini jusqu’à la valeur finale.

Figure 8 : La boîte de dialogue Remplir la série

Type de séries
Cette section définit le type de la suite.

– L’option Arithmétique crée une suite arithmétique en ajoutant l’incrément à la valeur pré-
cédente jusqu’à la valeur finale définie.

– L’option Géométrique crée une suite géométrique en multipliant la valeur précédente par 
l’incrément jusqu’à la valeur finale définie.

– L’option Date crée une suite de dates en ajoutant l’incrément à la date précédente jusqu’à
la date finale définie, compte tenu de l’unité de temps définie.

– L’option Remplir automatiquement crée une suite directement dans la feuille. La fonction 
de remplissage automatique prend en compte les listes personnalisées. Par exemple, si 
vous saisissez janvier dans la première cellule, la suite est complétée à partir de la liste 
définie dans la boîte de dialogue Options (Outils > Options > LibreOffice Calc > Listes 
de tri dans la barre de menu) (Figure 9). Le remplissage automatique essaie de détermi-
ner les valeurs d’une suite en définissant un incrément arithmétique. Par exemple, une 
suite numérique commençant par 1, 3, 5 est automatiquement complétée par 7, 9, 11, 13 ;
une suite de date commençant par 01/01/99 et 16/01/99 sera complétée par des dates 
espacées de quinze jours.

Unité de temps
Cette section vous permet de spécifier l’unité de temps désirée. Elle n’est active que si l’op-
tion Date a été cochée dans la section Type de série.

– L’option Jour crée une suite utilisant les sept jours de la semaine.

– L’option Jour de la semaine crée une suite utilisant cinq jours ouvrables (du lundi au ven-
dredi).
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– L’option Mois crée une suite dont l’incrément est en mois.

– L’option Année crée une suite dont l’incrément est en années.

Valeur initiale
Ce champ définit la valeur initiale de la suite. Utilisez des nombres, des dates ou des heures.

Valeur finale
Ce champ définit la valeur finale de la suite. Utilisez des nombres, des dates ou des heures.

Incrément
Ce champ définit la valeur par laquelle les éléments de la suite du type sélectionné sont mo-
difiés à chaque étape. La valeur ne peut être saisie que si le type de série arithmétique, géo-
métrique ou date a été sélectionné.

Définir une liste de remplissage

Pour définir vos propres listes de remplissage :

 1) Sélectionnez Outils > Options > LibreOffice Calc > Listes de tri dans la barre de menu  
(Figure 9). Celle-ci affiche les suites précédemment définies dans la zone Listes à gauche et 
le contenu de la liste sélectionnée dans la zone Entrées.

Figure 9 : La boîte de dialogue Listes de tri

 2) Cliquez sur Nouveau et la boîte Entrées se vide.

 3) Tapez la suite de la nouvelle liste dans la boîte Entrées (une valeur par ligne) (Figure 10).

 4) Cliquez sur Ajouter et la nouvelle liste apparaît désormais dans la zone Listes.

 5) Cliquez sur OK pour enregistrer la nouvelle liste.

Accélérer la saisie des données | 11



Figure 10 : création d’une nouvelle liste de tri

Définir une liste de remplissage à partir d’une plage d’une feuille

Vous pouvez définir une liste de remplissage à partir d’une plage de valeurs textuelles.

 1) Sélectionnez la plage qui contient les valeurs de texte que vous désirez utiliser comme liste 
de remplissage.

 2) Sélectionnez Outils > Options > LibreOffice Calc > Listes de tri (Figure 9).

 3) La plage sélectionnée se trouve dans le champ Copier la liste depuis. Cliquez sur Copier 
pour ajouter les valeurs aux listes de tri.

Utiliser les listes de sélection

Les listes de sélection sont disponibles uniquement pour des textes qui ont été déjà saisis dans la 
même colonne.

 1) Sélectionnez une cellule vide dans une colonne contenant déjà des entrées textuelles.

 2) Appuyez sur Alt+↓ (flèche vers le bas) ou faites un clic droit et choisissez Liste de sélec-
tion dans le menu contextuel. Une liste déroulante apparaît et propose le contenu de toutes 
les cellules de la même colonne qui ont au moins un caractère de texte ou dont le format est 
défini comme texte. Ces textes sont triés par ordre alphabétique et ceux qui ont des occur-
rences multiples n’apparaissent qu’une seule fois.

 3) Cliquez sur l’entrée dont vous avez besoin pour que le texte s’insère dans la cellule sélec-
tionnée.

Fusionner et scinder des cellules

Fusionner des cellules

Vous pouvez sélectionner des cellules adjacentes et les fusionner en une seule de la façon sui-
vante :

 1) Sélectionnez la plage de cellules contiguës que vous souhaitez fusionner.

 2) Effectuez l’une des actions suivantes :

– Faites un clic droit sur celle-ci et choisissez Fusionner les cellules dans le menu contex-
tuel.

– Sélectionnez Format > Fusionner les cellules > Fusionner les cellules ou Fusionner 
et centrer les cellules dans la barre de menu.

– Cliquez sur le bouton Fusionner et centrer les cellules  de la barre d’outils Forma-
tage.
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Le choix de Fusionner et centrer les cellules alignera leur contenu au centre des cellules 
fusionnées.

 3) Si les cellules contiennent des données, une boîte de dialogue (Figure 11) s’ouvre pour vous 
permettre de choisir de déplacer ou de masquer les données des cellules cachées par la fu-
sion.

 4) Faites votre choix et cliquez sur OK.

 5) Faites votre choix et 

! Attention

Fusionner des cellules peut conduire à des erreurs de calcul dans les formules utilisées par 
le classeur.

Figure 11 : Options de fusion des cellules non vides

Scinder les cellules

Vous ne pouvez scinder qu’une cellule créée par la fusion de plusieurs autres.

 1) Sélectionnez la cellule fusionnée.

 2) Effectuez une des actions suivantes :

– Faites un clic droit sur celle-ci et choisissez Scinder les cellules dans le menu contex-
tuel.

– Sélectionnez Format > Fusionner les cellules > Scinder les cellules dans la barre de 
menu.

– Cliquez sur le bouton Fusionner et centrer les cellules  de la barre d’outils Forma-
tage.

 3) Toutes les données resteront dans la première cellule. Si les cellules cachées par la fusion 
avaient un contenu avant celle-ci, vous pouvez avoir à les replacer manuellement à leur em-
placement initial.

Partager du contenu entre plusieurs feuilles

Il peut arriver que vous vouliez saisir la même information dans la même cellule de plusieurs 
feuilles, par exemple pour fixer des listes standard pour un groupe de personnes ou pour des orga-
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nismes. Au lieu de saisir la liste individuellement dans chaque feuille, vous pouvez la saisir en une 
fois pour toutes les feuilles. Pour cela,

 1) Choisissez Édition > Sélectionner > Sélectionner les feuilles dans la barre de menu pour 
ouvrir la boîte de dialogue Sélectionner des feuilles (Figure 12).

 2) Sélectionnez les feuilles où vous désirez que l’information soit répétée. Utilisez les touches 
Maj et Ctrl (Options sur Mac) pour sélectionner plusieurs feuilles.

 3) Cliquez sur OK pour sélectionner les feuilles dont les onglets changent de couleur.

 4) Saisissez les informations dans la feuille courante, elles seront répétées dans toutes les 
feuilles sélectionnées.

 5) N’oubliez pas de désélectionner les feuilles quand vous avez terminé la saisie des données 
que vous voulez répéter sur celles-ci.

Figure 12 : La boîte de dialogue Sélectionner des feuilles

! Attention

Cette technique écrase, sans aucun avertissement, toute information qui se trouve déjà 
dans les cellules des autres feuilles sélectionnées. Pour cette raison, quand vous avez fini, 
assurez-vous de bien désélectionner toutes les feuilles sauf celle que vous voulez modifier. 
(Ctrl+clic sur un onglet pour sélectionner ou désélectionner la feuille.)

Valider le contenu des cellules

Quand vous créez des classeurs destinés à être utilisés par d’autres personnes, vous désirez 
peut-être vous assurer qu’elles saisissent des données valides ou appropriées à la cellule. Vous 
pouvez également utiliser la validation pour votre propre usage comme guide pour saisir des don-
nées complexes ou rarement utilisées.

Les séries de remplissage et les listes de sélection peuvent convenir pour certains types de don-
nées, mais elles sont limitées à des informations prédéfinies. Par exemple, une cellule peut devoir 
recevoir uniquement une date ou un nombre entier, sans caractère alphabétique ni séparateur dé-
cimal ; ou bien encore une cellule ne doit pas être laissée vide.
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Selon les paramètres choisis pour la validation, l’outil peut aussi définir l’intervalle des valeurs qui 
peuvent être saisies, et fournir des messages d’aide qui expliquent les règles de validation que 
vous avez paramétrées pour cette cellule (ce que les utilisateurs devraient faire s’ils saisissent un 
contenu incorrect). Vous pouvez aussi paramétrer la cellule pour refuser un contenu incorrect, l’ac-
cepter avec un avertissement, ou, si vous êtes très organisé, exécuter une macro si une valeur er-
ronée est saisie.

Remarque

Une règle de validation est considérée comme une partie du format de la cellule. Si vous sé-
lectionnez Formats ou Tout supprimer depuis la boîte de dialogue Supprimer du contenu, 
alors elle sera supprimée. Si vous voulez copier une règle de validité avec le reste de la cel-
lule, utilisez Édition > Collage spécial > Formats ou Tout insérer.

Définir une validation

Pour valider toute nouvelle donnée saisie dans une cellule :

 1) Sélectionnez une cellule et choisissez Données > Validité sur la barre de menu pour ouvrir 
la boîte de dialogue Validité.

 2) Définissez, à l’aide des onglets Critère, Aide à la saisie et Message d’erreur de la boîte de 
dialogue, le type de contenu qui peut être entré dans la cellule. Les options possibles sont 
présentées ci-dessous.

Onglet Critère

Dans cet onglet (Figure 13), vous spécifiez les règles de validation des cellules sélectionnées. 
Vous pouvez, par exemple, définir des critères tels que Nombre entre 1 et 10 ou Texte de longueur
inférieure à 20 caractères.

Les options disponibles dans cet onglet dépendent du choix effectué dans la liste déroulante Auto-
riser.

Figure 13 : l’onglet Critère de la boîte de dialogue Validité

Autoriser
Choisissez, dans la liste déroulante, une option de validation pour les cellules sélectionnées.

– Toutes les valeurs : pas de limitation.
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– Nombres entiers : seuls les nombres entiers sont admis.

– Décimal : tout nombre de format décimal.

– Date : tout nombre correspondant à un format de date. Les valeurs saisies sont formatées
à l’appel suivant de la boîte de dialogue.

– Heure : tout nombre correspondant à un format d’heure. Les valeurs saisies sont forma-
tées à l’appel suivant de la boîte de dialogue.

– Plage de cellules : n’autorise que les valeurs données dans une plage de cellules. Celle-ci
peut être définie explicitement, par une plage de données ou par une plage nommée. Elle 
doit être constituée d’une seule colonne ou ligne de cellules. Si vous spécifiez une plage 
de plusieurs colonnes et lignes, seule la première colonne est utilisée.

– Liste : n’autorise que les valeurs ou chaînes définies dans une liste. Chaînes et valeurs 
peuvent être mélangées. Les nombres sont évalués indépendamment de leur format : si 
vous entrez 1 dans la liste, 100 % est aussi accepté.

– Longueur de texte : autorise les entrées dont la longueur est en accord avec le nombre de
caractères définis.

– Personnalisé : autorise les entrées qui correspondent à la formule définie dans la ligne de 
saisie Formule.

Autoriser les cellules vides
Associée à Outils > Audit > Marquer les données incorrectes, cette option définit si les 
cellules vides sont affichées comme donnée incorrecte (option non cochée) ou non affichées 
(option cochée).

Données
Sélectionnez dans la liste déroulante l’opérateur de comparaison utilisé. Celui-ci influe sur 
les options suivantes. Par exemple, si vous sélectionnez Plage correcte, les zones de saisie 
Minimum et Maximum remplace la zone de saisie Valeur.

Valeur
Saisissez ici la valeur qui valide les choix effectués dans les listes Autoriser et Données.

Minimum
Saisissez ici la plus petite valeur qui valide les choix effectués dans les listes Autoriser et 
Données.

Maximum
Saisissez ici la plus grande valeur qui valide les choix effectués dans les listes Autoriser et 
Données.

Source
Entrez dans cette ligne la plage de cellule qui contient les valeurs et textes autorisés.

Afficher la liste de sélection
Affiche une liste de toutes les chaînes et valeurs où effectuer une sélection. Cette liste peut 
aussi être ouverte en sélectionnant la cellule et en appuyant sur Ctrl+D.

Trier les entrées dans l’ordre croissant
Si cette option est cochée, la liste est triée en ordre croissant et les doublons sont filtrés. Si-
non, l’ordre de la liste source est conservé.
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Entrées
Saisissez-y les entrées qui seront des valeurs ou chaînes acceptées.

Onglet Aide à la saisie

Définissez ici le message affiché quand la cellule ou la plage de cellules est sélectionnée dans le 
classeur (Figure 14).

Figure 14 : l’onglet Aide à la saisie de la boîte de dialogue Validité

Afficher l’aide à la saisie lors de la sélection d’une cellule
Cochez cette option pour afficher, quand la cellule ou la plage de cellules est sélectionnée, le
message que vous entrez dans les zones de saisie Titre et Aide à la saisie. Si vous y avez 
saisi un texte et que vous décochez cette option, celui-ci sera perdu.

Titre
Saisissez ici le titre de l’infobulle qui s’affichera à la sélection de la cellule ou de la plage de 
cellules.

Aide à la saisie
Saisissez ici le message qui s’affichera dans l’infobulle à la sélection de la cellule ou de la 
plage de cellules.

Onglet Message d’erreur

Définissez ici le message d’erreur qui s’affichera à la saisie de données incorrectes dans la cellule 
(Figure 15).

Figure 15 : l’onglet Message d’erreur de la boîte de dialogue Validité.

Afficher un message d’erreur en cas de saisie de valeurs incorrectes
Cochez cette option pour que le message entré dans la zone de saisie Message d’erreur 
s’affiche en cas de saisie d’une valeur non acceptée dans la cellule.
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Action
Sélectionnez l’action à effectuer quand une valeur non acceptée est saisie dans la cellule.

– Arrêter : rejette la saisie et affiche une boîte de dialogue à refermer par un bouton OK.

– Avertissement et Information : affiche une boîte de dialogue qui peut être refermée par un 
bouton OK ou un bouton Annuler. La valeur saisie n’est rejetée que si vous cliquez sur le
bouton Annuler.

– Macro : exécute une macro après l’affichage du message d’erreur. Le bouton Parcourir 
est activé pour vous permettre d’ouvrir la boîte de dialogue Sélecteur de macro où vous 
pourrez choisir la macro qui sera exécutée en cas de saisie rejetée. La macro est exécu-
tée après l’affichage du message d’erreur.

Titre
Saisissez ici le titre de la macro ou du message qui sera affiché quand une valeur non ac-
ceptée est saisie dans la cellule.

Message d’erreur
Saisissez ici le message qui sera affiché quand une valeur non acceptée est saisie dans la 
cellule.

Audit

L’outil Audit vous permet de mettre en évidence les cellules dont le contenu ne répond pas aux cri-
tères de validation. Ceci peut se produire si l’action en cas d’erreur est un avertissement ou une in-
formation.

 1) Choisissez Outils > Audit > Marquer les données incorrectes dans la barre de menu pour
trouver les cellules avec des données incorrectes. La fonction Audit entoure toutes les cel-
lules qui contiennent des données incorrectes avec un ovale (Figure 16).

Figure 16 : données incorrectes marquées par la fonction Audit.

 2) Corrigez les données incorrectes par de nouvelles valeurs acceptées.

 3) Sélectionnez Outils > Audit > Supprimer tous les repères dans la barre de menu et les 
cellules qui étaient marquées comme contenant des données incorrectes ne le sont plus.

Remarque

Une règle de validité est considérée comme un élément du format de la cellule. Elle sera 
supprimée si vous choisissez Tout supprimer dans la boîte de dialogue Supprimer du 
contenu (Figure 18). Si vous voulez copier une règle de validité avec le reste de la cellule, 
utilisez le menu Édition > Collage spécial > Collage spécial pour ouvrir la boîte de dia-
logue Collage spécial (Figure 19) et cochez l’option Tout coller ou l’option Formats puis cli-
quez sur OK.
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Modifier les données

Supprimer des données

Supprimer seulement les données d’une cellule

Les données seules peuvent être supprimées dans une cellule sans en affecter le formatage. Cli-
quez dans la cellule pour la sélectionner et appuyez ensuite sur la touche Suppr.

Supprimer des cellules

Dans ce cas les cellules, lignes ou colonnes sélectionnées sont complètement supprimées. Les 
cellules situées en dessous ou à droite prennent leur place.

 1) Sélectionnez une cellule ou une plage de cellules.

 2) Effectuez une des actions suivantes :

– appuyez sur les touches Ctrl+-,

– sélectionnez Feuille > Supprimer des cellules dans la barre de menu,

– ouvrez le menu contextuel par un clic droit et sélectionnez Supprimer.

Elles ouvrent la boîte de dialogue Supprimer des cellules (Figure 17).

Figure 17 : La boîte de dialogue Supprimer des cellules

 3) Celle-ci propose quatre options qui définissent la disposition de la feuille après la suppres-
sion des cellules :

– Déplacer les cellules vers le haut : les cellules supprimées seront remplacées par celles 
qui sont en dessous d’elle.

– Déplacer les cellules vers la gauche : les cellules supprimées seront remplacées par 
celles qui sont à leur droite.

– Supprimer des lignes entières : supprime entièrement les lignes qui comportent au moins 
une cellule sélectionnée.

– Supprimer des colonnes entières : supprime entièrement les colonnes qui comportent au 
moins une cellule sélectionnée.

 4) Confirmez la suppression en appuyant sur OK.
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Remarque

L’option choisie est mémorisée et proposée par défaut à l’ouverture suivante de la boîte de 
dialogue.

Supprimer les données et le formatage

Les données et le formatage peuvent être supprimés d’une cellule en une seule fois.

 1) Sélectionnez une cellule ou une plage de cellules.

 2) Effectuez une des actions suivantes :

– Appuyez sur la touche Retour arrière,

– faites un clic droit et choisissez Effacer le contenu dans le menu contextuel,

– sélectionnez Feuille > Effacer des cellules dans la barre de menu.

Elles ouvrent la boîte de dialogue Supprimer du contenu (Figure 18). Dans cette boîte de 
dialogue, plusieurs attributs de la cellule peuvent être supprimés.

 3) Sélectionnez les options désirées ou, pour tout supprimer dans une cellule (contenu et for-
mat), cochez l’option Tout supprimer. Cliquez sur OK.

Figure 18   : La boîte de dialogue Supprimer du contenu

Remplacer toutes les données dans une cellule

Pour supprimer les données et insérer de nouvelles données, tapez simplement par-dessus les 
anciennes données. Les nouvelles données conserveront le format des précédentes.

Vous pouvez aussi cliquer dans la ligne de saisie de la barre de formule, puis faire un double-clic 
sur les données pour les sélectionner totalement avant de taper les nouvelles données.

Modifier les données dans une cellule

Il est parfois nécessaire de changer le contenu d’une cellule sans le supprimer totalement, par 
exemple quand la phrase “Jean va partir” se trouve dans une cellule et doit être changée en “Jean 
va partir demain.”

Avec le clavier

 1) Cliquez dans la cellule désirée pour la sélectionner.

 2) Appuyez sur la touche F2 et le curseur sera placé à la fin de la cellule.
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 3) Effectuez une des deux actions suivantes :

– appuyez sur la touche Retour arrière pour supprimer les données jusqu’à l’endroit où
vous voulez en saisir de nouvelles ;

– utilisez les flèches du clavier pour déplacer le curseur dans le texte de la cellule à la posi-
tion où débute la modification, puis utiliser les touches Suppr et Retour arrière pour 
effacer les données non désirées avant d’en saisir de nouvelles.

 4) Appuyez sur la touche Entrée quand vous avez terminé pour enregistrer vos modifications.

Remarque

Quand une cellule est sélectionnée, son contenu est affiché dans la ligne de saisie de la 
barre de formule. Il est peut-être plus simple de les modifier à cet endroit.

Avec la souris

 1) Faites un double-clic dans la cellule voulue pour la sélectionner et placer le curseur à l’inté-
rieur pour modification.

 2) Cliquez dans la cellule pour placer le curseur à l’endroit où vous désirez commencer les mo-
difications et effectuer celles-ci.

Vous pouvez aussi

 1) Cliquer sur la cellule pour la sélectionner.

 2) Cliquer à l’intérieur de la ligne de saisie à l’emplacement des modifications à effectuer.

Quand vous avez terminé, cliquez hors de la cellule pour la désactiver et enregistrer vos modifica-
tions.

La fonction Collage spécial

Vous pouvez utiliser la fonction Collage spécial pour coller dans une cellule des éléments choisis 
de la cellule ou de la plage de cellules de départ, par exemple son format ou le résultat de la for-
mule qu’elle contient.

La boîte de dialogue Collage spécial

 1) Sélectionnez une cellule ou une plage de cellules.

 2) Copiez son contenu

– en sélectionnant Édition > Copier dans la barre de menu,

– en faisant un clic droit et en choisissant Copier le menu contextuel,

– en cliquant sur l’icône Copier  dans la barre d’outils Standard,

– en appuyant sur Ctrl+C.

 3) Sélectionnez la cellule ou la plage de cellules cible.

 4) Ouvrez la boîte de dialogue Collage spécial,

– en sélectionnant Édition > Collage spécial > Collage spécial dans la barre de menu,
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– en choisissant Collage spécial > Collage spécial dans le menu contextuel après un clic 
droit.

– en appuyant sur Ctrl+Maj+V.

 5) Faites votre choix parmi les options des sections Sélection, Opération, Options et Dépla-
cer les cellules qui sont présentées ci-dessous.

 6) Cliquez sur OK pour coller les données dans la cellule ou la plage de cellules cible et refer-
mer la boîte de dialogue.

Figure 19 : la boîte de dialogue Collage spécial.

Les options de la boîte de dialogue Collage spécial

Sélection
Sélectionnez un format pour le contenu du presse-papier que vous voulez coller.

– Tout coller : colle tout le contenu des cellules, commentaires, formats et objets dans le do-
cument actif.

– Texte : colle les cellules qui contiennent du texte.

– Nombres : colle les cellules qui contiennent des nombres.

– Date & heure : colle les cellules qui contiennent des valeurs de date ou d’heure.

– Formules : colle les cellules qui contiennent des formules.

– Commentaires : colle les commentaires attachés aux cellules. Si vous désirez ajouter le 
commentaire au contenu d’une cellule existante, sélectionnez l’opération Additionner.

– Formats : colle les attributs de format de la cellule.

– Objets : colle les objets contenus dans la plage de cellules sélectionnée. Cela peut être 
des objets OLE, des objets diagrammes ou des objets dessins.
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Opérations
Choisissez l’opération à appliquer quand vous collez les cellules dans la feuille.

– Aucun : aucune opération n’est appliquée quand vous insérez la plage de cellule depuis le
presse-papier. Son contenu remplace celui des cellules cibles.

– Additionner : ajoute les valeurs des cellules dans le presse-papier à celles des cellules 
cibles. Si le presse-papier ne contient que des commentaires, ceux-ci sont ajoutés aux 
cellules cibles.

– Soustraire : soustrait les valeurs des cellules dans le presse-papier de celles des cellules 
cibles.

– Multiplier : multiplie les valeurs des cellules cibles par celles des cellules dans le presse-
papier.

– Diviser : divise les valeurs des cellules cibles par celles des cellules dans le presse-pa-
pier.

Options
Définissez les options de collage du contenu du presse-papier.

– Ignorer les cellules vides : les cellules vides contenues dans le presse-papier ne rem-
placent pas les cellules cibles. Quand elle est associée aux opérations Multiplier ou Divi-
ser, celles-ci ne sont pas appliquées aux cellules cibles des cellules vides du presse-pa-
pier. Si vous ne cochez pas cette option, les cellules vides du presse-papier sont traitées 
pour les opérations mathématiques comme si elles contenaient zéro. Par exemple, si 
vous appliquez l’opération Multiplier, les cellules cibles prendront la valeur zéro.

– Transposer : les lignes de la plage contenue dans le presse-papier sont collées dans les 
colonnes de la plage cible, et les colonnes de la plage contenue dans le presse-papier 
sont collées dans les lignes de la plage cible.

– Lier : la plage de cellules est insérée sous forme de lien, si bien que les modifications ap-
portées aux cellules du fichier source sont reportées dans le fichier cible. Pour être certain
que les changements effectués aux cellules vides dans le fichier source sont mis à jour 
dans le fichier cible, n’oubliez pas de cocher Tout coller. Il est aussi possible de lier des 
feuilles du même classeur. Quand vous créez un lien vers d’autres fichiers, c’est automati-
quement un lien DDE qui est inséré comme formule matricielle et qui ne peut être modifié 
que dans son ensemble.

Déplacer les cellules
Choisissez le déplacement opéré sur les cellules cibles quand le contenu du presse-papier 
est inséré.

– Ne pas déplacer : les cellules insérées remplacent les cellules cibles.

– Vers le bas : les cellules cibles sont décalées vers le bas quand vous insérez celles du 
presse-papier.

– À droite : les cellules cibles sont décalées vers la droite quand vous insérez celles du 
presse-papier.
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Collage spécial simplifié

Si vous désirez ne coller que du texte, des nombres ou des formules dans la cellule ou la plage de 
cellules cible :

 1) Sélectionnez la cellule ou la plage de cellule source et copiez les données dans le presse-
papier.

 2) Sélectionnez la cellule ou la plage de cellule cible.

 3) Ouvrez le menu contextuel par un clic droit et sélectionnez Collage spécial > Texte, 
Nombre ou Formule.

Insérer un champ dans une cellule

Vous pouvez insérer dans une cellule un champ correspondant à la date du jour, au nom de la 
feuille ou au nom du document.

 1) Sélectionnez une cellule et faites un double clic pour la mettre en mode d’édition.

 2) Faites un clic droit, puis, dans le menu contextuel, choisissez Insérer un champ > Date, 
Nom de la feuille ou Titre du document.

Remarque

La commande Insérer un champ > Titre du document insère le nom du classeur et non le 
titre défini dans l’onglet Description de la boîte de dialogue Propriétés du fichier.

Astuce

Les champs sont actualisés lors de l’enregistrement du classeur ou via le raccourci clavier 
Ctrl+Maj+F9.

Formater les données

Remarque

Tous les paramétrages abordés dans cette section peuvent aussi être affectés à un style de 
cellule. Voir le chapitre 4, Utiliser les styles et les modèles, pour plus d’informations.

La mise en forme des données peut être effectuée de plusieurs manières dans Calc, soit en la dé-
finissant comme élément d’un style de cellule pour qu’elle soit automatiquement appliquée, soit en 
l’appliquant manuellement à la cellule. Pour un meilleur contrôle et des options supplémentaires, 
sélectionnez une cellule ou une plage de cellules et utilisez la boîte de dialogue Formatage des 
cellules. Toutes les options de mise en forme sont présentées ci-dessous.

Formater plusieurs lignes de texte

Plusieurs lignes de texte peuvent être saisies dans une seule cellule en utilisant le renvoi à la ligne
automatique ou des retours manuels à la ligne. Chaque méthode est utile dans différentes situa-
tions.
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Utiliser le retour à la ligne automatique

Avec la boîte de dialogue Formatage des cellules

Pour que le texte revienne à la ligne en fin de cellule,

 1) Sélectionnez une cellule ou une plage de cellules.

 2) Ouvrez la boîte de dialogue Formatage des cellules (Figure 20) par l’une des méthodes sui-
vantes :

– faites un clic droit sur la cellule et sélectionnez Formater les cellules dans le menu 
contextuel,

– sélectionnez Format > Cellules dans la barre de menu,

– utilisez le raccourci Ctrl+1 au clavier.

 3) Cliquez sur l’onglet Alignement (Figure 20).

Figure 20   : L’onglet Alignement de la boîte de dialogue Formatage des cellules.

 4) Dans la section Propriétés, cochez l’option Renvoi à la ligne automatique et cliquez sur OK. 
Le résultat est montré ci-dessous (Figure 21).

Figure 21 : Retour à la ligne automatique

Formater les données | 25



Avec le volet latéral

 1) Sélectionnez la cellule.

 2) Dans le volet latéral, ouvrez l’onglet Alignement puis la section Format numérique (cliquez 
sur le + ou ˅ à gauche du titre pour ouvrir celle-ci).

 3) Cochez Ajuster le texte pour appliquer immédiatement le formatage.

Figure 22 : Formatage du retour à la ligne.

Utiliser les sauts de ligne manuels

Pour insérer un saut de ligne manuel pendant la frappe dans une cellule, appuyez sur 
Ctrl+Entrée. Cette méthode ne fonctionne pas si le curseur est dans la ligne de saisie de la 
barre de formule. Pour insérer un saut de ligne dans un texte déjà saisi, faites un double-clic dans 
la cellule à l’endroit où vous voulez faire un saut de ligne avant d’appuyer sur Ctrl+Entrée.

Quelle que soit la méthode (renvoi à la ligne automatique ou saut de ligne manuel), la hauteur de 
ligne est adaptée pour afficher toutes les lignes de la cellule, mais, en cas de saut de ligne manuel,
la largeur de cellule ne change pas et le texte peut encore déborder à la fin de la cellule. Vous de-
vez modifier manuellement la largeur de la cellule ou repositionner votre saut de ligne pour que 
votre texte ne déborde pas de la fin de la cellule.

Ajuster le texte à la taille de la cellule

La taille de police des données d’une cellule peut être automatiquement ajustée pour remplir la 
cellule.

 1) Sélectionnez la cellule ou la plage de cellules.

 2) Ouvrez la boîte de dialogue Formatage des cellules par l’une des méthodes suivantes :

– faites un clic droit sur la cellule et sélectionnez Formater les cellules dans le menu 
contextuel,

– sélectionnez Format > Cellules dans la barre de menu,

– utilisez le raccourci Ctrl+1 au clavier.

 3) Cochez l’option Ajuster à la taille de la cellule dans la section Propriétés de l’onglet Aligne-
ment (Figure 20) puis cliquez sur OK.

Formater les nombres

Plusieurs formats de nombres différents peuvent être appliqués aux cellules en utilisant les icônes 
de la barre d’outils Formatage (Figure 23). Sélectionnez la cellule, puis cliquez sur l’icône corres-
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pondante. Certaines icônes peuvent ne pas être visibles avec le réglage par défaut ; faites un clic 
droit sur une icône de la barre puis choisir Boutons visibles dans le menu contextuel et sélection-
nez les icônes à afficher.

Figure 23   : Icônes de formats de nombres dans la barre d’outils Formatage.
De gauche à droite  : général, monnaie, pourcentage, nombre, date, scientifique,

ajouter une décimale, supprimer une décimale.

Pour un meilleur contrôle ou pour sélectionner d’autres formats de nombres, utilisez l’onglet 
Nombres (Figure 24) de la boîte de dialogue Formatage des cellules :

• appliquez aux données l’un des types de la liste Catégorie ;

• paramétrez le nombre de décimales et de zéros non significatifs dans Options ;

• saisissez une description du format personnalisée.

Figure 24 : La boîte de dialogue Formatage des cellules, onglet Nombres

Le champ Langue détermine les paramètres locaux pour les différents formats comme l’ordre 
dans les dates et le symbole de l’unité monétaire.

Certains formats numériques sont accessibles depuis le panneau Formats numériques du Volet 
latéral dans l’onglet Propriétés (Figure 25). Cliquez sur le bouton Plus d’options  pour ouvrir la
boîte de dialogue Formatage des cellules décrite ci-dessus.
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Figure 25 : Icônes de formats numériques dans le panneau Format numérique du volet latéral

Formater la police

Pour choisir rapidement la police utilisée dans une cellule :

 1) Sélectionnez la cellule ou la plage de cellules.

 2) Cliquez sur la flèche à droite du champ Nom de police dans la barre d’outils Formatage (Fi-
gure 26) et choisissez une police dans la liste. Il est aussi possible de changer la police 
grâce à l’onglet Police de la boîte de dialogue Formatage des cellules.

 3) Pour choisir la taille de la police, cliquez sur la flèche près du champ Taille de police dans la 
barre d’outils Formatage et choisissez une taille dans la liste. Elle peut aussi être modifiée 
dans l’onglet Police de la boîte de dialogue Formatage des cellules.

Figure 26 : Mise en forme du texte dans la barre d’outils Formatage

 4) Pour d’autres attributs, vous pouvez utiliser les boutons Gras ( ), Italique ( ) ou Souli-
gnage ( ).

 5) Pour modifier l’alignement horizontal du paragraphe, cliquez sur un des boutons d’aligne-
ment (Gauche , Centré , Droite , Justifié )1. Vous trouverez des choix supplémen-
taires dans l’onglet Alignement la boîte de dialogue Formatage des cellules (raccourci 
Ctrl+1) en déroulant la liste Horizontal de la section Alignement du texte.

 6) Pour modifier l’alignement vertical du texte dans la cellule, cliquez sur un des trois boutons 
Aligner en haut ( ), Centrer verticalement ( ) et Aligner en bas ( ) de la barre d’outils 
Formatage, Vous disposerez de choix supplémentaires dans l’onglet Alignement la boîte de 
dialogue Formatage des cellules (raccourci Ctrl+1) (Figure 20) et sélectionnez une option 
dans la liste déroulante Vertical de la section Alignement du texte.

 7) Pour choisir une couleur de police, cliquez sur la flèche à droite de l’icône Couleur de police
 pour afficher la palette des couleurs. Cliquez sur la couleur voulue.

L’onglet Propriétés du Volet latéral possède cinq panneaux, Styles, Caractère, Alignement, For-
mat Numérique et Apparence de la cellule qui contiennent tous les contrôles de mise en forme de 
la barre d’outils Formatage.

Vous pouvez aussi utiliser le bouton Plus d’options  de l’un des panneaux du Volet latéral pour 
ouvrir la boîte de dialogue Formatage des cellules.

Remarque

Pour spécifier la langue de la cellule (utile pour permettre à plusieurs langues de coexister 
dans un même document avec une vérification orthographique efficace), utilisez l’onglet Po-
lice de la boîte de dialogue Formatage des cellules.

1 Ces boutons sont aussi disponibles dans le panneau Alignement de l’onglet Propriétés du volet latéral.
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Astuce

Pour choisir si les noms de polices s’affichent en texte standard ou dans leur propre police, 
sélectionnez Outils > Options > LibreOffice > Affichage dans la barre de menu et cochez 
ou non l’option Afficher l’aperçu des polices dans la section Listes des polices. Pour plus 
d’information, voir le chapitre 14, Paramétrer et personnaliser Calc.

Effets de caractères

 1) Sélectionnez la cellule ou la plage de cellules.

 2) Ouvrez la boîte de dialogue Formatage des cellules par l’une des méthodes suivantes :

– faites un clic droit sur la cellule et sélectionnez Formater les cellules dans le menu 
contextuel,

– sélectionnez Format > Cellules dans la barre de menu,

– utilisez le raccourci Ctrl+1 au clavier.

 3) Ouvrez l’onglet Effets de caractère (Figure 27).

 4) Sélectionnez les effets que vous souhaitez utiliser parmi les options proposées. Celles-ci 
sont décrites au chapitre 4, Utiliser les styles et les modèles.

 5) Cliquez sur OK pour les appliquer et refermer la boîte de dialogue.

Figure 27 : l’onglet Effets de caractère de la boîte de dialogue Formatage des cellules.

Les modifications des effets de caractères sont appliquées à la sélection courante, à la totalité du 
mot qui contient le curseur ou au texte que vous allez saisir par la suite.

Direction du texte

Pour modifier la direction du texte dans une cellule, utilisez l’onglet Alignement de la boîte de dia-
logue Formage des cellules (Figure 20 page 25).

Dans la section Orientation du texte,
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 1) Sélectionnez le Bord de référence à partir duquel la rotation sera effectuée :

– Extension du texte à partir du bord inférieur de la cellule : le texte pivoté est écrit à partir 
du bas de la cellule vers l’extérieur.

– Extension du texte à partir du bord supérieur de la cellule : le texte pivoté est écrit à partir 
du haut de la cellule vers l’extérieur.

– Extension du texte à l’intérieur de la cellule : le texte pivoté n’est écrit que dans la cellule.

 2) Réglez l’orientation du texte en cliquant sur la petite marque au bord du disque et en glissant
la souris pour le faire tourner ou utilisez le champ de saisie Degrés.

 3) Cochez l’option Empilé verticalement pour que le texte apparaisse verticalement dans la cel-
lule, mais avec des lettres horizontales.

Utiliser les icônes de la barre d’outils Formatage

Remarque

Les icônes qui gèrent l’orientation du texte ne sont accessibles que si l’option Asiatique est 
cochée dans la section Langue par défaut des documents de la page Paramètres linguis-
tiques – Langues de la boîte de dialogue Options (Outils > Options > Paramètres linguis-
tiques > Langues dans la barre de menu). De même pour rendre accessibles les icônes qui
gèrent le sens du texte, l’option Mise en page de texte complexe doit être cochée au même 
endroit.

De plus, pour que ces boutons soient visibles, il faut personnaliser la barre d’outils : faire un 
clic droit sur une icône, sélectionner Boutons visibles dans le menu contextuel puis cliquer 
sur l’icône désirée.

Certains boutons de la barre d’outils Formatage peuvent servir à régler l’orientation du texte d’une 
cellule sélectionnée :

• Pour changer l’orientation du texte d’horizontale (direction par défaut) en verticale, cliquez 
sur le bouton Orientation du texte de haut en bas .

• Pour changer l’orientation du texte de verticale en horizontale (direction par défaut), cliquez 
sur le bouton Orientation du texte de gauche à droite .

• Pour changer le sens du texte de gauche à droite, qui est le sens par défaut des polices oc-
cidentales, en de droite à gauche, qui est utilisé par certaines polices, par exemple les po-
lices arabes, cliquez sur le bouton De droite à gauche . Le sens du texte n’est modifié 
que si la police est conçue pour une écriture de droite à gauche.

• Pour retrouver le sens du texte de gauche à droite utilisé par défaut par les polices occiden-
tales, cliquez sur le bouton De gauche à droite .
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Formater les bordures des cellules

Pour formater la bordure d’une cellule ou d’un groupe de cellules sélectionnées, vous pouvez utili-
ser les boutons de la barre d’outils Formatage ou la boîte de dialogue Formatage des cellules pour
un meilleur contrôle. Voir le chapitre 4, Utiliser les styles et les modèles, pour plus d’informations 
sur ces options.

Remarque

Les propriétés de bordure de cellule ne s’appliquent qu’aux cellules sélectionnées, et ne 
peuvent être modifiées que dans celles-ci. Par exemple, si la cellule C3 a une bordure haute
(ce qui est visuellement équivalent à une bordure basse dans C2), cette bordure ne pourra 
être supprimée qu’en sélectionnant C3. Elle ne pourra pas être supprimée dans C2.

Figure 28 : l’onglet Bordures de la boîte de dialogue Formatage des cellules.

 1) Sélectionnez une cellule ou une plage de cellules.

 2) Ouvrez la boîte de dialogue Formatage des cellules par l’une des méthodes suivantes :

– faites un clic droit sur la cellule et sélectionnez Formater les cellules dans le menu 
contextuel,

– sélectionnez Format > Cellules dans la barre de menu,

– utilisez le raccourci Ctrl+1 au clavier.

 3) Dans l’onglet Bordures (Figure 28), sélectionnez les options désirées.

 4) Cliquez sur OK pour refermer la boîte de dialogue et enregistrer les modifications.

Vous pouvez aussi utiliser les boutons de la barre d’outils Formatage pour appliquer un choix pré-
défini de bordures :
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• cliquez l’icône Bordures  et choisissez une disposition proposée par la palette,

• cliquez sur l’icône Style de bordure  et choisissez un style de ligne dans la liste dérou-
lante,

• cliquez sur l’icône Couleur de bordure  et choisissez une couleur dans la palette.

Remarque

Quand vous utilisez l’icône Bordures de la barre d’outils Formatage, vous pouvez simple-
ment cliquer sur celle-ci pour ajouter une bordure à celles qui existent ou appuyer simultané-
ment sur la touche Maj pour supprimer les bordures existantes et ajouter la nouvelle.

Formater l’arrière-plan des cellules

Pour choisir rapidement une couleur d’arrière-plan pour une cellule ou d’un groupe de cellules, cli-
quez sur la petite flèche près de l’icône Couleur d’arrière-plan dans la barre d’outils Forma-
tage. Une palette de choix de couleurs, identique à la palette Couleur de police, est affichée.

Vous pouvez également utiliser l’onglet Arrière-plan de la boîte de dialogue Formatage des cel-
lules :

 1) Sélectionnez une cellule ou une plage de cellules.

 2) Ouvrez la boîte de dialogue Formatage des cellules par l’une des méthodes suivantes :

– faites un clic droit sur la cellule et sélectionnez Formater les cellules dans le menu 
contextuel,

– sélectionnez Format > Cellules dans la barre de menu,

– utilisez le raccourci Ctrl+1 au clavier.

 3) Dans l’onglet Arrière-plan, sélectionnez les options désirées.

 4) Cliquez sur OK pour refermer la boîte de dialogue et enregistrer les modifications.

La section Apparence de cellule dans l’onglet Propriétés du volet latéral contient un contrôle Ar-
rière-plan de cellule avec une palette de couleurs.

Voir le chapitre 4, Utiliser les styles et les modèles, pour plus de détails.

Format automatique des cellules et des feuilles

Utiliser l’AutoFormat

Vous pouvez utiliser la fonction AutoFormat de Calc pour mettre en forme rapidement et facilement
un groupe de cellules. Elle vous permet aussi de donner très facilement le même aspect à diffé-
rentes plages de la feuille. Toutes les mises en forme appliquées le sont par formatage direct.

 1) Sélectionnez les cellules que vous voulez formater dans au moins trois colonnes et trois 
lignes, y compris les en-têtes de colonnes et de lignes.

 2) Sélectionnez Format > Styles d’AutoFormat dans la barre de menu pour ouvrir la boîte de 
dialogue AutoFormat (Figure 29).

 3) Choisissez le type et la couleur de formatage dans la liste.
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 4) Sélectionnez les propriétés de formatage à inclure dans la fonction autoformat. La boîte de 
dialogue affiche immédiatement les effets des options que vous cochez ou décochez.

 5) Cliquez sur OK.

Figure 29 : La boîte de dialogue AutoFormat

Définir un nouvel autoformat

Vous pouvez définir un nouvel autoformat qui sera disponible pour tous les classeurs.

 1) Mettez en forme le type de données, la police, sa taille, les bordures, l’arrière-plan, etc. d’une
plage d’au moins 4 cellules sur 4 puis sélectionnez-la.

 2) Choisissez Édition > Tout sélectionner dans la barre de menu pour sélectionner toute la 
feuille

 3) Sélectionnez Format > Styles d’AutoFormat dans la barre de menu pour ouvrir la boîte de 
dialogue AutoFormat où le bouton Ajouter est maintenant actif.

 4) Cliquez sur Ajouter.

 5) Dans la zone Nom de la boîte de dialogue Ajouter un AutoFormat qui s’ouvre alors, tapez un
nom significatif pour le nouveau format.

 6) Cliquez sur OK pour l’enregistrer. Le nouvel autoformat est maintenant disponible dans la 
liste Format de la boîte de dialogue AutoFormat.

Utiliser les thèmes

Calc offre un ensemble prédéfini de thèmes de formatage (ensembles de styles) que vous pouvez 
appliquer aux classeurs. Il n’est pas possible d’ajouter de nouveaux thèmes à Calc ni de modifier 
les thèmes prédéfinis. Vous pouvez toutefois modifier les styles d’un thème après l’avoir appliqué à
un classeur. Ces styles modifiés ne seront disponibles que dans ce classeur quand vous l’enregis-
trez.

Pour appliquer un thème à un classeur :
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 1) Sélectionnez Format > Thèmes pour classeur dans la barre de menu ou cliquez sur l’icône
Thèmes pour classeur  dans la barre d’outils Outils. Si celle-ci n’est pas visible, sélec-
tionnez Affichage > Barres d’outils dans la barre de menu et cliquez sur Outils. La boîte 
de dialogue Sélection de thème s’ouvre (Figure 30). Il donne la liste des thèmes applicables
à l’ensemble du classeur.

 2) Choisissez le thème que vous désirez appliquer. Dès votre choix effectué, les styles du 
thème sont appliqués au classeur et immédiatement visibles.

 3) Cliquez sur OK.

Figure 30 : La boîte de dialogue Sélection de thème

Si vous le souhaitez, vous pouvez alors ouvrir l’onglet Styles et Formatage du volet latéral pour 
modifier des styles particuliers. Ces modifications ne changent pas le thème : elles ne font que 
changer l’apparence du style dans le classeur précis que vous utilisez. Pour plus d’informations 
sur la modification des styles, voyez le chapitre 4, Utiliser les styles et les modèles.

! Attention

Si vous appliquez un deuxième thème après un premier, les modifications des styles de ce 
premier thème seront supprimées au profit des styles du second thème.

Mise en évidence des valeurs

Cette fonction affiche le contenu des cellules avec des couleurs différentes selon le type de don-
nées. La Figure 31 montre un exemple de contenu mis en évidence.

• Le texte est affiché en noir.

• Les formules sont affichées en vert.

• Les nombres sont affichés en bleu.
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Figure 31 : exemple de mise en évidence des valeurs.

Les couleurs de mise en évidence des valeurs remplacent les couleurs utilisées dans le formatage,
mais uniquement à l’écran : quand le classeur est imprimé, les couleurs appliquées initialement 
pour la mise en forme sont utilisées.

Sélectionnez Affichage > Mise en évidence des valeurs dans la barre de menu, ou appuyez sur 
Ctrl+F8, pour activer ou désactiver cette fonction. Quand cette fonction est désactivée, les cou-
leurs initialement appliquées par le formatage réapparaissent.

Cette fonction peut également être activée par défaut en sélectionnant Outils > Options > 
LibreOffice Calc > Affichage et en cochant l’option Mise en évidence des valeurs. Cette action va
appliquer la mise en évidence des valeurs à chaque fois que vous ouvrirez Calc, ce qui n’est peut-
être pas ce que vous souhaitez si vous avez l’intention de formater les cellules avant impression.

Utiliser le formatage conditionnel

Vous pouvez paramétrer le formatage des cellules pour qu’il change selon des conditions que vous
spécifiez. Le formatage conditionnel sert à mettre en valeur des données hors des spécifications 
que vous avez définies. Il est recommandé de ne pas en faire un usage excessif sous peine de ré-
duire l’impact de ces données hors spécifications.

Voir page 39 un exemple d’utilisation du formatage conditionnel.

Remarque

Pour appliquer un formatage conditionnel, Calculer automatiquement doit être activé. 
Choisissez Données > Calculer > Calculer automatiquement dans la barre de menu.

Le formatage conditionnel est lié à l’utilisation des styles. Si vous n’êtes pas familier des 
styles, référez-vous au Chapitre 4, Utiliser les styles et les modèles.

Définir un formatage conditionnel

 1) Assurez-vous que le calcul automatique est actif (Données > Calculer > Calculer automati-
quement).

 2) Dans votre classeur, sélectionnez les cellules auxquelles vous voulez appliquer un forma-
tage conditionnel.

 3) Choisissez Format > Conditionnel > Condition (Figure 32), Échelle de couleur (Figure 
34), Barre de données (Figure 35), Jeu d’icônes (Figure 36) ou Date dans la barre de 
menu ou cliquez sur le bouton  de la barre d’outils Formatage puis sélectionnez un type 
de formatage conditionnel dans le menu déroulant. La boîte de dialogue Formatage condi-
tionnel s’ouvre et affiche la liste des conditions déjà définies.
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Figure 32 : la boîte de dialogue Formatage conditionnel – Condition

 4) Cliquez sur Ajouter et saisissez une nouvelle condition. Répétez cette étape autant que né-
cessaire.

 5) Sélectionnez un style déjà défini dans la liste déroulante Appliquer un style. Vous pouvez 
aussi sélectionner la première entrée de la liste, Nouveau style, pour ouvrir la boîte de dia-
logue Style de cellule (Figure 33) où vous pourrez créer un nouveau style de cellule.

Figure 33 : La boîte de dialogue Style de cellule

 6) Cliquez sur OK pour enregistrer les conditions et refermer la boîte de dialogue. Les cellules 
sélectionnées sont désormais formatées dans le style correspondant.
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Types de formatages conditionnels

Condition

C’est la porte d’entrée dans l’utilisation du formatage conditionnel. Vous pouvez y définir les for-
mats à utiliser pour mettre en évidence n’importe quelle donnée du classeur qui se situe hors des 
spécifications que vous avez définies.

Échelle de couleur

Utilisez l’Échelle de couleur pour définir la couleur d’arrière-plan en fonction de la valeur de la 
donnée dans une cellule. Elle ne peut être utilisée que si la condition sélectionnée s’applique à 
Toutes les cellules. Vous pouvez utiliser deux ou trois couleurs pour définir l’échelle.

Figure 34 : la boîte de dialogue Formatage conditionnel – Échelle de couleurs.

Barres de données

Les barres de données offrent une représentation graphique des données du classeur, d’après 
leurs valeurs dans une plage sélectionnée. Cliquez sur Plus d’options dans la boîte de dialogue 
pour paramétrer l’aspect des barres. Les barres de données ne sont utilisables que si la condition 
s’applique à Toutes les cellules.

Figure 35 : la boîte de dialogue Formatage conditionnel – Barres de données.
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Jeu d’icônes

Les jeux d’icônes affichent, à côté de la donnée de chacune des cellules sélectionnées, une icône 
qui donne une représentation visuelle de la position de la donnée dans un intervalle que vous avez
défini. Les jeux d’icônes disponibles comportent des flèches colorées ou grises, des drapeaux, des
signes, des symboles colorés, des barres, des quartiers… Les jeux d’icônes ne sont utilisables que
si la condition s’applique à Toutes les cellules.

Figure 36 : la boîte de dialogue Formatage conditionnel – Barres de données

Gestion de formatage conditionnel

Pour voir tous les formatages conditionnels définis dans le classeur et les styles utilisés :

 1) Sélectionnez Format > Conditionnel > Gérer dans la barre de menu ou cliquez sur le bou-
ton  de la barre d’outils Formatage puis sélectionnez Gérer pour ouvrir la boîte de dia-
logue Gérer le formatage conditionnel (Figure 37).

 2) Sélectionnez une plage dans la liste Plage et

– cliquez sur Éditer pour modifier le formatage conditionnel ;

– cliquez sur Supprimer pour supprimer le formatage conditionnel. La suppression est im-
médiate, sans confirmation ;

– vous pouvez aussi cliquer sur Ajouter pour créer une nouvelle définition de formatage 
conditionnelle. Attention : celle-ci s’applique aux cellules sélectionnées dans la feuille et 
non à la plage choisie dans la liste.

 3) Cliquez sur OK pour enregistrer les modifications et refermer la boîte de dialogue.

Figure 37 : la boîte de dialogue Gérer le formatage conditionnel.
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Copier les styles de cellules

Pour appliquer le formatage conditionnel utilisé à d’autres cellules :

 1) Cliquez sur une cellule qui a reçu le formatage conditionnel désiré et copiez-la dans le 
presse-papier.

 2) Sélectionnez la cellule ou la plage de cellules qui doit recevoir le même formatage que la cel-
lule copiée dans le presse-papier.

 3) Choisissez Édition > Collage spécial > Collage spécial dans la barre de menu pour ouvrir 
la boîte de dialogue Collage spécial (Figure 19 page 22).

 4) Vérifiez que seule l’option Formats est cochée et cliquez sur OK pour appliquer le formatage 
conditionnel aux cellules sélectionnées.

Exemple de formatage conditionnel

Le formatage conditionnel permet, par exemple, de mettre en évidence les valeurs qui dépassent 
la moyenne de toutes les valeurs. Si celles-ci changent, la mise en forme s’adapte en consé-
quence, sans que vous ayez à appliquer d’autres styles manuellement. On désire afficher les va-
leurs au-dessus de la moyenne en vert et celles en dessous celles-ci en rouge.

Générer les valeurs

 1) Pour obtenir une valeur aléatoire entre 0 et 50 dans la cellule A1, saisissez dans celle-ci la 
formule =ENT(ALEA()*50). (ALEA() produit un nombre décimal entre 0 et 1 et ENT trans-
forme le résultat en entier.)

 2) Pour copier la formule dans les cellules suivantes, tirez le petit carré en bas à droite de la 
cellule sélectionnée jusqu’à la cellule A10.

Calculer la moyenne

Dans notre exemple, nous allons calculer la moyenne des valeurs aléatoires et placer le résultat 
dans une cellule.

 1) Sélectionnez la cellule A12 (ou une autre cellule vide), cliquez sur l’icône Assistant Fonc-
tions ( ) de la barre de formule ou choisissez Insertion > Fonction dans la barre de menu
pour ouvrir l’assistant Fonctions.

 2) Sélectionnez Moyenne et définissez la plage d’application à A1:A10.

 3) Appuyez sur Entrée.

Définir les styles des cellules

Nous allons maintenant définir un style pour les cellules dont le contenu est supérieur à la 
moyenne et une autre pour celles dont le contenu est inférieur à la moyenne.

 1) Faites un clic droit dans une cellule vide et sélectionnez Formater les cellules dans le menu
contextuel pour ouvrir la boîte de dialogue Formatage des cellules.

 2) Dans l’onglet Effets de caractère, ouvrez la palette Couleur de police et sélectionnez une 
couleur rouge. Refermez la boîte de dialogue en cliquant sur OK.
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 3) Dans la barre de menu, choisissez Styles > Nouveau style à partir de la sélection et nom-
mez le nouveau style En dessous dans la boîte de dialogue Créer un style. Cliquez sur OK 
pour valider et refermer la boîte de dialogue.

 4) Recommencez les étapes 1 à 3 dans une autre cellule en sélectionnant une couleur verte et 
nommez le style Au-dessus.

Appliquer les styles aux cellules

Nous pouvons appliquer le style conditionnel aux cellules de A1 à A10.

 1) Sélectionnez les cellules de A1 à A10.

 2) Ouvrez la boîte de dialogue Formatage conditionnel – Condition (Format > Conditionnel > 
Condition dans la barre de menu ou  puis Condition dans la barre d’outils Formatage).

 3) Saisissez les deux conditions « La valeur de la cellule est inférieure à $A$12 » avec le style 
En dessous et « La valeur de la cellule est supérieure à $A$12 » avec le style Au-dessus. 
(Les $ assurent que la référence de la cellule reste fixe).

Figure 38 : Exemple de formatage conditionnel.

Masquer et afficher les données

Quand des éléments sont masqués, ils ne sont ni visibles ni imprimables, mais ils peuvent toujours
être sélectionnés pour une copie si vous sélectionnez les éléments autour d’eux. Par exemple, si 
la colonne B est masquée, elle est copiée si vous sélectionnez les colonnes A et C. Quand vous 
avez à nouveau besoin d’un élément masqué, vous pouvez inverser le processus et afficher l’élé-
ment.

Masquer des données

Masquer des feuilles

Pour masquer des feuilles, sélectionnez celles que vous voulez masquer puis choisissez Masquer
la feuille dans le menu Feuille ou dans le menu contextuel qui s’ouvre par un clic droit sur l’onglet 
d’une des feuilles sélectionnées. Les feuilles ne sont plus visibles ni imprimées.

Vous ne pouvez pas masquer toutes les feuilles d’un classeur ; au moins une feuille doit rester vi-
sible.

Masquer des lignes et des colonnes

Pour masquer des lignes ou des colonnes :
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 1) Sélectionnez une cellule dans la ligne ou la colonne que vous voulez masquer.

 2) Sélectionnez Format dans la barre de menu et cliquez sur Ligne ou Colonne.

 3) Choisissez Masquer dans le menu et la ligne ou la colonne n’est plus visible ni imprimée.

Vous pouvez aussi faire un clic droit sur l’en-tête de la ligne ou de la colonne et cliquer sur Mas-
quer des lignes ou des colonnes dans le menu contextuel.

Masquer des cellules

Masquer des cellules individuelles est plus compliqué. Vous devez commencer par donner aux cel-
lules le statut de cellules protégées et masquées, puis vous devez protéger la feuille.

 1) Sélectionnez les cellules que vous souhaitez masquer.

 2) Ouvrez la boîte de dialogue Formatage des cellules (Format > Cellules dans la barre de 
menu, Formater des cellules dans le menu contextuel ou Ctrl+1 au clavier).

 3) Dans l’onglet Protection de cellule, sélectionnez une option pour masquer les cellules à 
l’écran ou à l’impression (Figure 39).

Figure 39 : l’onglet Protection de cellule de la boîte de dialogue Formatage des cellules.

 4) Cliquez sur OK pour valider les modifications et refermer la boîte de dialogue.

 5) Sélectionnez Outils > Protéger la feuille pour ouvrir la boîte de dialogue Protéger la feuille 
(Figure 40).

 6) Cochez Protéger cette feuille et le contenu des cellules verrouillées.

 7) Saisissez un mot de passe et confirmez-le.

 8) Dans la section Autoriser les utilisateurs de cette feuille à, cochez ou non les options per-
mettant à l’utilisateur de sélectionner les cellules protégées ou non protégées.

 9) Cliquez sur OK pour enregistrer les modifications et refermer la boîte de dialogue.

Remarque

Quand des cellules sont masquées, seules les données qu’elles contiennent sont cachées 
et les cellules protégées ne peuvent pas être modifiées. Les cellules elles-mêmes restent vi-
sibles et vides dans le classeur.

Masquer et afficher les données | 41



Figure 40 : la boîte de dialogue Protéger la feuille.

Afficher les données masquées

Afficher des feuilles

Pour afficher des feuilles masquées, sélectionnez Afficher les feuilles dans le menu Feuille ou 
dans le menu contextuel qui s’ouvre par un clic droit sur un onglet de feuille visible. Choisissez en-
suite les feuilles que vous voulez de nouveau afficher dans la liste de la boîte de dialogue Afficher 
la feuille qui s’ouvre alors. Les feuilles redeviendront visibles et seront imprimées.

Afficher des lignes et des colonnes

Pour afficher les lignes et colonnes masquées :

 1) Sélectionnez les lignes ou colonnes de chaque côté de celles qui sont masquées.

 2) Choisissez Format > Ligne ou Format > Colonne dans la barre de menu.

 3) Sélectionnez Afficher dans le sous-menu et la ligne ou la colonne sera affichée et pourra 
être imprimée.

Vous pouvez aussi faire un clic droit sur l’en-tête d’une ligne ou d’une colonne sélectionnée et cli-
quer sur Afficher les lignes ou les colonnes dans le menu contextuel.

Remarque

Si la première colonne (A) ou la première ligne (1) est masquée, vous devez sélectionner la 
feuille entière pour avoir accès à la commande Afficher pour cette ligne ou cette colonne.

Afficher des cellules

 1) Choisissez Outils > Protéger la feuille dans la barre de menu pour ouvrir la boîte de dia-
logue Protéger la feuille (Figure 40).

 2) Saisissez le mot de passe, déprotégez la feuille, et cliquez sur OK.

 3) Ouvrez la boîte de dialogue Formatage des cellules (Format > Cellules dans la barre de 
menu, Formater des cellules dans le menu contextuel ou Ctrl+1 au clavier).
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 4) Dans l’onglet Protection de cellule (Figure 39), décochez les options de masquage des cel-
lules puis cliquez sur OK.

Plans et groupes

Si vous masquez et affichez régulièrement les mêmes cellules, vous pouvez créer un plan de vos 
données pour grouper les lignes ou les colonnes et pouvoir les masquer en fermant le groupe ou 
les afficher en l’ouvrant d’un simple clic.

Les contrôles de base de groupement et de plan affiche un plus (+) ou un moins (-) sur l’indicateur 
du groupe pour permettre de l’afficher ou de le masquer (Figure 41). Si des groupes sont imbri-
qués les uns dans les autres, ils ont des boutons numérotés pour vous permettre d’agir sur diffé-
rents niveaux de groupes imbriqués.

Grouper

Pour grouper des lignes ou des colonnes :

 1) Sélectionnez les cellules que vous désirez grouper.

 2) Choisissez Données > Plan et groupe > Grouper dans la barre de menu ou appuyez sur la
touche F12.

 3) Dans la boîte de dialogue Grouper qui s’ouvre alors, sélectionnez Lignes ou Colonnes et 
cliquez sur OK. Un indicateur de groupe apparaît à gauche des lignes ou au-dessus des co-
lonnes groupées, comme le montre la Figure 41.

Figure 41 : Indicateur de lignes groupées.

Masquer les détails

Pour masquer les détails d’un groupe de lignes ou de colonnes :

 1) Cliquez sur le signe moins (-) de l’indicateur de groupe.
Vous pouvez aussi sélectionner une cellule du groupe puis choisir Données > Plan et 
groupe > Masquer les détails dans la barre de menu.

 2) Les lignes ou les colonnes sont masquées et le signe moins sur l’indicateur de groupe de-
vient un signe plus.

Afficher les détails

Pour afficher les détails d’un groupe de lignes ou de colonnes masquées :

 1) Cliquez sur le signe plus (+) de l’indicateur de groupe.
Vous pouvez aussi sélectionner une cellule du groupe puis choisir Données > Plan et 
groupe > Afficher les détails dans la barre de menu.
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 2) Les lignes ou les colonnes sont affichées et le signe plus sur l’indicateur de groupe devient 
un signe moins.

Dégrouper

Pour dégrouper un groupe de lignes ou de colonnes :

 1) Vérifiez que les lignes ou colonnes groupées sont visibles.

 2) Choisissez Données > Plan et groupe > Dissocier dans la barre de menu ou appuyez sur 
les touches Ctrl+F12.

 3) Si seules des lignes ou des colonnes étaient groupées, elles sont dégroupées. Si des lignes 
et des colonnes étaient groupées, choisissez, dans la boîte de dialogue Grouper qui s’ouvre 
alors, Lignes ou Colonnes et cliquez sur OK.

! Attention

Les groupes de lignes ou de colonnes masqués doivent être rendus visibles. S’ils sont mas-
qués au moment du dégroupement, elles sont supprimées du classeur.

Remarque

Si des groupes sont imbriqués, seul le dernier créé est dégroupé.

Créer un Autoplan

Si une plage de cellules sélectionnées contient des formules ou des références, Calc peut grouper 
automatiquement des cellules de la sélection. Par exemple, dans la Figure 42, les cellules du 1er et
du 2e trimestre contiennent la somme des trois cellules à leur gauche. Si vous utilisez la com-
mande AutoPlan, celles-ci sont groupées en deux trimestres.

Pour appliquer la commande AutoPlan, sélectionnez Données > Plan et groupe > AutoPlan 
dans la barre de menu. Calc va automatiquement rechercher les cellules qui contiennent des for-
mules ou des références et grouper les cellules en conséquence.

Figure 42 : Exemple d’AutoPlan.

Supprimer l’AutoPlan

Pour supprimer les groupements de lignes ou de colonnes créés par la fonction AutoPlan, sélec-
tionnez Données > Plan et groupe > Supprimer le contour dans la barre de menu. Si des lignes
ou des colonnes étaient masquées, elles sont de nouveau affichées dans le classeur.

Filtrer les enregistrements

Un filtre est une liste de conditions que chaque entrée doit respecter pour être affichée. Calc offre 
trois types de filtres :

• Standard qui spécifie les conditions logiques de filtrage des données.
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• AutoFiltre qui filtre les données selon une valeur ou une chaîne définie. Il filtre automatique-
ment la plage de cellules sélectionnées et transforme la première ligne en une série de listes
déroulantes où vous pouvez choisir les éléments que vous souhaitez afficher.

• Spécial qui utilise des critères spécifiés dans des cellules.

Appliquer un filtre standard

Un filtre standard est plus complexe qu’un autofiltre. Vous pouvez y définir jusqu’à huit conditions, 
combinées par des opérateurs ET et OU. Ils sont surtout utiles avec des nombres, bien que 
quelques opérateurs conditionnels s’appliquent aussi au texte.

 1) Sélectionnez une plage de cellules dans le classeur.

 2) Choisissez Données > Plus de filtres > Filtre Standard dans la barre de menu pour ouvrir 
la boîte de dialogue Filtre Standard (Figure 43).

Figure 43 : la boîte de dialogue Filtre standard.

 3) Définissez les critères de filtrage et les options du filtre que vous désirez utiliser.

 4) Cliquez sur OK pour appliquer votre filtre et refermer la boîte de dialogue. Tous les enregis-
trements qui correspondent aux critères et options que vous avez définis seront visibles.

Le critère de filtrage utilisé dans un filtre standard est défini par une combinaison de lignes consti-
tuées du nom d’un champ, d’une condition logique et d’une valeur reliées par des connecteurs lo-
giques ET ou OU.

Opérateur
À partir de la deuxième ligne, vous pouvez choisir entre ET et OU.

Nom de champ
Choisissez dans la liste déroulante le nom du champ à filtrer. Si les noms ne sont pas dispo-
nibles, les identifiants des colonnes sont utilisés.

Condition
Choisissez ici un opérateur de comparaison qui reliera l’entrée choisie pour le nom du 
champ et la valeur sélectionnée.
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Valeur
Spécifiez ici une valeur qui servira à filtrer le champ. La liste déroulante contient toutes les 
valeurs possibles pour le champ défini auparavant, ainsi que les options Vide et Non vide. 
Faites votre choix parmi celles-ci.

Respecter la casse
Cochez cette option pour que les majuscules soient distinguées des minuscules au cours du 
filtrage.

La plage contient des étiquettes de colonnes
Si cette option est cochée, les cellules de la première ligne définissent les étiquettes des 
champs.

Copier le résultat vers
Cochez cette option, et sélectionnez une plage de cellules, où vous voulez afficher les résul-
tats du filtre. Vous pouvez aussi choisir une plage nommée dans la liste déroulante.

Caractères génériques
Cochez cette option pour utiliser des caractères génériques dans les critères du filtre. Vous 
trouverez dans l’aide le LibreOffice une liste des expressions régulières acceptées. Vous 
pouvez les utiliser dans le champ Valeur si la condition est = (égal) ou <> (différent). Cela 
s’applique aussi aux cellules concernées auxquelles vous faites référence pour un filtre spé-
cial.

Sans doublons
Cochez cette option pour exclure les lignes en double de la liste des données filtrées.

Conserver les critères de filtre
En cas de copie des résultats, si cette option est cochée, la plage de destination reste liée à 
la plage source. Celle-ci doit avoir été définie comme plage de base par Données > Définir 
la plage Vous pouvez aussi réappliquer le filtre à tout moment en cliquant dans la plage 
source puis sur Données > Actualiser la plage dans la barre de menu.

Appliquer un AutoFiltre

Un autofiltre ajoute une liste déroulante aux cellules de la première ligne d’une ou plusieurs co-
lonnes où vous pouvez filtrer les lignes à afficher. Les listes comportent toutes les entrées diffé-
rentes de chaque colonne sélectionnée, dans l’ordre lexicographique (l’ordre du dictionnaire). Un 
autofiltre peut être utilisé sur plusieurs feuilles sans avoir à définir d’abord une plage de base de 
données.

En plus de ces valeurs uniques, les filtres automatiques comprennent des options pour afficher 
toutes les valeurs, les 10 valeurs numériques les plus fortes, les valeurs vides ou non vides. Ce-
pendant, ils sont quelque peu limités. En particulier, ils ne permettent pas l’usage des expressions 
régulières, et donc vous ne pouvez pas les utiliser pour afficher des contenus de cellules qui sont 
similaires, mais pas identiques.

 1) Sélectionnez une plage de cellules dans le classeur. Si vous voulez appliquer plusieurs auto-
filtres à la même feuille, vous devez d’abord définir des plages de base de données puis leur
appliquer les autofiltres.

 2) Choisissez Données > AutoFiltre dans la barre de menu ou cliquez sur l’icône AutoFiltre
 dans la barre d’outils Standard. Un bouton fléché est ajouté à la première cellule de 

chaque colonne de la plage sélectionnée.
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 3) Cliquez sur le bouton fléché de la colonne qui contient la valeur ou la chaîne que vous vou-
lez définir comme critère de filtrage (Figure 44).

Figure 44 : Exemple d’AutoFiltre.

 4) Sélectionnez une ou plusieurs valeurs ou chaînes.

 5) La liste est filtrée et n’affiche que les lignes avec cette ou ces valeurs. Les numéros des 
lignes qui correspondent sont affichés et les numéros des autres lignes sont masqués. La 
flèche en haut de la colonne choisie pour filtrer les données change de couleur et comporte 
un indicateur dans son coin inférieur droit (Figure 45).

Figure 45 : lignes filtrées et bouton modifié par un autofiltre.

Appliquer un filtre spécial

Un filtre spécial a une structure semblable à celle du filtre standard. La différence réside en ce que 
les arguments du filtre spécial ne sont pas entrés dans une boîte de dialogue, mais ils peuvent être
saisis dans une zone vide d’un classeur, puis référencés par la boîte de dialogue du filtre pour être 
appliqués.

 1) Copiez les en-têtes de données dans une partie vide de la feuille. Dans les cellules en des-
sous, insérez les données qui vont servir de filtre. Pour que les filtres soient reliés par un ET, 
saisissez les données sous les en-têtes correspondants et sur la même ligne. Pour qu’ils 
soient reliés par un OU, saisissez les données sur des lignes différentes (Figure 46).
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Figure 46 : critères de filtre spécial relié par ET et OU : 
(Prénom = Alice ET Commune = Lille) OU Commune = Strasbourg.

 2) Sélectionnez une plage de cellules contenant les données à filtrer.

 3) Choisissez Données > Plus de filtres > Filtre spécial dans la barre de menu pour ouvrir la 
boîte de dialogue Filtre spécial (Figure 47).

Figure 47 : La boîte de dialogue Filtre spécial.

 4) Dans la section Lire les critères de filtre dans, sélectionnez une plage nommée ou saisis-
sez une plage de cellule qui contient les en-têtes des colonnes et les critères de filtrage que 
vous désirez utiliser.

 5) Cliquez sur OK pour appliquer le filtre et refermer la boîte de dialogue. Tous les enregistre-
ments qui correspondent aux critères et options que vous avez définis sont affichés.

Figure 48 : résultat du filtre spécial précédent

Remarque

Les options de filtrage spécial sont les mêmes que ceux qui concernent le filtrage standard. 
Voir « Appliquer un filtre standard » page 45 pour plus d’informations.

Pour un exemple de filtre spécial, voir la page de l’aide qui a pour titre « Filtre : application de 
filtres spéciaux ».

Trier les enregistrements

Le tri modifie la disposition des cellules dans la feuille. Dans Calc, vous pouvez utiliser simultané-
ment plusieurs critères de tri, qui sont appliqués l’un après l’autre. Les tris sont pratiques quand 
vous cherchez un élément particulier, et sont encore plus puissants combinés aux filtres.
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De plus, le tri est souvent utile quand vous ajoutez de nouvelles données. Quand une liste est 
longue, il est habituellement plus facile d’ajouter des données en bas de la feuille, plutôt que d’in-
sérer des lignes à leur bonne place. Après avoir ajouté des données, vous pouvez les trier pour 
mettre à jour la feuille.

La boîte de dialogue Trier

Pour trier les cellules d’un classeur avec la boîte de dialogue Trier :

 1) Sélectionnez les cellules, lignes ou colonnes à trier.

 2) Choisissez Données > Trier dans la barre de menu pour ouvrir la boîte de dialogue.

 3) Dans l’onglet Options (Figure 50), choisissez de trier les lignes ou les colonnes. Reportez-
vous à la section « Options de tri », page 49, pour plus de détails.

 4) Dans l’onglet Critères de tri (Figure 49), sélectionnez le critère grâce aux listes déroulantes 
créées d’après les cellules sélectionnées.

Figure 49 : l’onglet Critères de tri de la boîte de dialogue Trier.

 5) Choisissez l’ordre de tri en cochant soit l’option Croissant (de A à Z et de 0 à 9), soit l’option 
Décroissant (de Z à A et de 9 à 0).

 6) Cliquez sur OK pour effectuer le tri dans le classeur.

Remarque

Si des cellules sélectionnées pour le tri sont protégées ainsi que la feuille, Calc ne peut pas 
modifier ces cellules et le tri n’est pas effectué. Un message d’erreur est affiché pour indi-
quer que les cellules protégées ne peuvent pas être modifiées. Il est cependant possible de 
trier une plage contenant une ligne d’en-têtes de colonnes qui sont protégés puisqu’ils ne 
sont pas modifiés par le tri.

Options de tri

Dans l’onglet Options de la boîte de dialogue Trier, vous pouvez définir les options suivantes :
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Figure 50 : l’onglet Options de la boîte de dialogue Trier.

Sensible à la casse
Pour deux entrées par ailleurs identiques, celle avec une lettre majuscule est placée avant 
celle avec une lettre minuscule dans la même position si le tri est décroissant ; si le tri est 
croissant, alors l’entrée avec une lettre majuscule est placée après celle avec une lettre mi-
nuscule dans la même position.

Note

Pour les langues asiatiques, cochez l’option Sensible à la casse pour appliquer un groupe-
ment à plusieurs niveaux : les entrées sont d’abord comparées dans leur forme primitive en 
ignorant leurs casses et signes diacritiques. Si elles sont reconnues identiques, leurs signes 
diacritiques sont pris en compte pour une comparaison de deuxième niveau. Si elles sont 
encore reconnues identiques, leurs casses, largeurs de caractères et différence en Kana ja-
ponais sont considérées pour une comparaison de troisième niveau.

La plage contient des étiquettes de colonne/ligne
Si cette option est cochée, la première colonne ou ligne de la sélection est omise pendant le 
tri. Le choix de la direction de tri en bas de la boîte de dialogue détermine l’intitulé et la fonc-
tion de cette option : du haut vers le bas, l’option concerne les étiquettes de colonnes ; de 
gauche à droite, elle concerne les étiquettes de lignes.

Inclure les formats
Le formatage d’une cellule est déplacé avec son contenu. Si un formatage est utilisé pour 
distinguer différents types de cellules, alors utilisez cette option.

Activer le tri naturel
Le tri naturel est un algorithme qui trie des chaînes contenant des nombres selon la valeur 
de la partie numérique au lieu d’utiliser l’ordre lexicographique traditionnel pour les chaînes. 
Par exemple, si vous avez une suite de valeurs telles que A1, A2, A3, …, A19, A20, A21. Si 
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cette option n’est pas cochée, elles seront triées dans l’ordre A1, A11, A12, … , A19, A2, A20,
A21. Si elle est cochée, elles seront triées dans l’ordre des nombres de 1 à 21.

Inclure les colonnes limites ne contenant que des commentaires
Si cette option est cochée, l’association entre ces cellules et les cellules triées est mainte-
nue.

Inclure les colonnes limites ne contenant que des images
Si cette option est cochée, l’association entre ces cellules et les cellules triées est mainte-
nue.

Copier le résultat du tri à
Si vous cochez cette option, sélectionnez dans la liste en dessous une plage nommée ou 
saisissez une plage de cellules où les cellules triées seront copiées et affichées.

Ordre de tri personnalisé
Si vous cochez cette option, sélectionnez dans le champ en dessous une liste qui définit 
l’ordre à appliquer. Les choix possibles sont définis dans la page LibreOffice Calc – Listes de
tri de la boîte de dialogue Options (Outils > Options > LibreOffice Calc > Listes de tri 
dans la barre de menu). Voir « Définir une liste de remplissage » page 11.

Langue
Sélectionnez la langue dont les règles de tri sont utilisées.

Options
Sélectionnez une option de tri pour la langue. Par exemple, sélectionner l’option « Annuaire 
téléphonique » pour l’allemand inclut le caractère « umlaut » dans le tri.

Du haut vers le bas (trier les lignes)
Trie les lignes selon les valeurs dans les colonnes actives dans la plage sélectionnée.

De gauche à droite (trier les colonnes)
Trie les colonnes selon des valeurs dans les lignes actives de la plage sélectionnée.

Tri rapide

Si les colonnes du classeur possèdent un en-tête au format texte, vous pouvez effectuer un tri ra-
pide.

 1) Sélectionnez une plage de cellules à trier.

 2) Choisissez Données > Tri croissant ou Tri décroissant dans la barre de menu ou cliquez 
sur le bouton Tri croissant  ou Tri décroissant  dans la barre d’outils standard.

Recherche et remplacement

Calc propose deux façons de rechercher du texte dans un document : la barre d’outils Rechercher 
pour une recherche rapide et la boîte de dialogue Rechercher & remplacer. La barre d’outils est 
simple et rapide, mais ses fonctionnalités sont plus limitées que celles de la boîte de dialogue.

Utiliser la barre d’outils Rechercher

 1) Sélectionnez Affichage > Barres d’outils > Rechercher ou Édition > Rechercher, ou ap-
puyez sur Ctrl+F, pour ouvrir la barre d’outils Rechercher (Figure 51). Elle est ancrée par 
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défaut en bas à gauche de la fenêtre de Calc, mais peut être libérée et placée à un autre en-
droit.

Figure 51 : la barre d’outils Rechercher.

Vous pouvez fermer cette barre d’outils en cliquant sur le bouton à l’extrémité gauche ou en 
appuyant sur la touche Échap.

 2) Tapez un terme à rechercher dans le champ Rechercher.

 3) Pour affiner la recherche, vous pouvez cocher l’option Respecter la casse. Par exemple, si le
terme recherché est Paris, en cochant Respecter la casse, vous trouverez Paris mais pas 
paris. Vous pouvez aussi cocher l’option Affichage mis en forme.

 4) Cliquez ensuite sur le bouton Rechercher le suivant  ou Rechercher le précédent . 
Pour trouver les autres occurrences de ce même terme, cliquez de nouveau sur ce bouton.

Utiliser la boîte de dialogue Rechercher & remplacer

Pour afficher la boîte de dialogue Rechercher & remplacer (Figure 52), utilisez le raccourci clavier 
Ctrl+H, choisissez Édition > Rechercher & remplacer dans la barre de menu ou cliquez sur 
l’icône Rechercher & Remplacer  dans la barre d’outils Rechercher ou la barre d’outils Stan-
dard.

Figure 52 : la boîte de dialogue Rechercher et remplacer.

Rechercher

 1) Saisissez ce que vous recherchez dans le champ Rechercher de la boîte de dialogue Re-
chercher et remplacer.

 2) Si nécessaire, cliquez sur Autres options pour accéder à d’autres filtres de recherche.

 3) Cliquez sur Rechercher le suivant pour localiser la première occurrence de ce qui est re-
cherché.
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 4) Cliquez de nouveau sur Rechercher le suivant pour en localiser les occurrences suivantes. 
Continuez tant que nécessaire.

 5) Vous pouvez aussi cliquer sur Tout rechercher pour localiser toutes les cellules qui 
contiennent ce que vous recherchez. Elles seront mises en évidence dans le classeur et une
petite boîte de dialogue avec la liste de leurs emplacements va s’ouvrir.

Remplacer

 1) Saisissez ce que vous recherchez dans le champ Rechercher de la boîte de dialogue Re-
chercher et remplacer.

 2) Saisissez le contenu de remplacement dans le champ Remplacer.

 3) Si nécessaire, cliquez sur Autres options pour accéder à d’autres filtres de recherche.

 4) Pour parcourir les cellules et choisir de remplacer ou non leur contenu :

 a) Cliquez sur Rechercher le suivant pour localiser la première occurrence de ce qui est re-
cherché.

 b) Cliquez sur Remplacer pour remplacer le contenu de la cellule par celui du champ Rem-
placer et passer à l’occurrence suivante du critère de recherche.

Vous pouvez aussi

 a) Cliquer sur Remplacer pour localiser la première occurrence de ce qui est recherché et la
remplacer sans passer à la suivante.

 b) Utiliser soit Rechercher le suivant, soit Remplacer pour passer à l’occurrence suivante.

Ou enfin, pour localiser et remplacer toutes les occurrences de ce que vous recherchez sans
vous arrêter à chacune d’elle, cliquez sur Tout remplacer.

! Attention

N’utilisez Tout remplacer qu’avec précaution, au risque de commettre des erreurs très gê-
nantes qui peuvent demander une recherche manuelle mot par mot pour être corrigées si 
elles ne sont pas découvertes à temps pour être annulées.

Options de recherche et remplacement

Les options de la boîte de dialogue Rechercher et remplacer sont les suivantes :

Rechercher
Saisissez le texte à rechercher ou sélectionnez une recherche précédente dans la liste.

Respecter la casse
Si cette option est cochée, distinction est faite entre les majuscules et les minuscules.

Affichage formaté
Cochez cette option pour inclure les caractères de formatage de nombres dans la recherche.
Par exemple, si une cellule contient une valeur monétaire, $123,45, et une autre la même 
valeur avec le formatage par défaut, 123,45, rechercher « $123,45 » trouvera la première 
mais pas la seconde.
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Cellules entières
Si cette option est cochée, la recherche porte sur les cellules identiques au texte de la re-
cherche.

Toutes les feuilles
Cochez cette option pour effectuer une recherche dans toutes les feuilles du classeur.

Remplacer
Saisissez le texte de remplacement ou sélectionnez un texte de remplacement récent ou un 
style dans la liste.

Sélection active uniquement
Si cette option est cochée, la recherche n’est effectuée que dans le texte ou les cellules sé-
lectionnés.

Remplacer à rebours
Si cette option est cochée, la recherche commence à l’endroit où se trouve le curseur et s’ef-
fectue vers le début du fichier.

Expressions régulières
Cochez cette option pour utiliser des expressions régulières dans les recherches. Voir l’aide 
de LibreOffice pour plus d’information sur l’utilisation des expressions régulières.

Styles de cellule
Si cette option est cochée, la recherche porte sur les cellules qui ont le formatage que vous 
avez sélectionné dans la liste déroulante du champ Rechercher. Pour spécifier un style de 
remplacement, sélectionnez-le dans la liste déroulante du champ Remplacer.

Recherche de similarité
Cochez cette option pour rechercher des termes similaires au texte saisi dans Rechercher. 
Cliquez sur le bouton Similarités pour définir les options de similarité.

Respecter la chasse
(uniquement si la prise en charge des langues asiatiques est activée) : si cette option est co-
chée, la recherche distingue les formes de caractères de demi et pleine chasse.

Similarités japonaises
(uniquement si la prise en charge des langues asiatiques est activée) : si cette option est co-
chée, vous pouvez spécifier les options de recherche pour des notations similaires utilisées 
dans un texte en japonais. Activez-la puis cliquez sur le bouton Sons pour spécifier les op-
tions de recherche.

Caractères joker
Cochez cette option pour utiliser des jokers dans le texte du champ Rechercher.

Sensible à la diacritique
Cochez cette option pour inclure les signes diacritiques et les accents dans la recherche.

Direction
Détermine l’ordre de recherche dans les cellules : Lignes pour rechercher de gauche à 
droite, ligne après ligne. Colonnes pour rechercher du haut vers le bas, colonne après co-
lonne.
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Rechercher dans
– Formules recherche les caractères que vous avez indiqués dans les formules et dans les 

valeurs fixes (non calculées). Par exemple, vous pouvez rechercher des formules qui 
contiennent "SOMME".

– Valeurs recherche les caractères que vous avez spécifiés dans les valeurs et dans les ré-
sultats des formules.

– Notes recherche les caractères que vous avez spécifiés dans les commentaires qui sont 
attachés aux cellules.

La boîte de dialogue Résultats de la recherche

Figure 53 : La boîte de dialogue Résultats de la recherche

Quand vous avez cliqué sur Tout rechercher ou Tout remplacer dans la boîte de dialogue Re-
chercher & remplacer, ou sur Tout rechercher dans la barre d’outils Rechercher, le comportement
par défaut de Calc est initialement d’afficher la boîte de dialogue Résultats de la recherche (Figure 
53) une fois l’opération achevée. Elle résume les résultats tandis que les cellules concernées sont 
mises en valeur dans le classeur.

La boîte de dialogue Résultats de la recherche donne la liste des cellules trouvées et leur contenu 
courant (après remplacement). Elle indique aussi le nombre de cellules concernées. Si vous déco-
chez l’option Afficher ce dialogue en bas de la boîte de dialogue avant de cliquer sur le bouton 
Fermer, elle ne sera plus affichée après un clic sur Tout rechercher ou Tout remplacer. Son affi-
chage peut aussi être contrôlé en cochant ou non l’option Récapitulatif de la recherche dans la 
section Fenêtre de la page LibreOffice Calc – Affichage dans la boîte de dialogue Options (Outils 
> Options > LibreOffice Calc > Affichage dans la barre de menu).
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